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The first version of the Moog Modular V was 
commercialized in March 2003 having been 
announced at the NAMM show of the same 
year.  
 
It quickly became popular being the first to 
offer an emulation of a modular 
synthesizer.  
 
The name Moog® was obviously a trigger 
as for many it remains synonymous with 
the golden age of vintage synthesizers. But 
strong interest from well-known musicians 
such as Isao Tomita, Klaus Schultze, Geof 
Downes, Stevie Wonder, Herbie Hancock 
and many others helped create a real buzz 
around the launch of the Moog Modular V.  
 
At Arturia, we have received many 
messages of congratulations as well as 
requests for the evolution and modifications 
for upcoming versions of the synthesizer.  
 
Version 2 of the Moog Modular V has taken 
many of these requests into account and 
brings many unexpected developments.  
 
Firstly, as you will see when you launch the 
program, is a new means of viewing the 
synthesizer giving an overview of the entire 
instrument if your computer can support 
the resolution. On screens with lower 
resolutions, by using the “scroll” command, 
it becomes possible to access all of the 
modules on the same screen, a feature that 
will delight many musicians.  
We have also broadened the configuration 
possibilities for the synthesizer. Some 
modules can now be interchanged, which 

brings the Moog Modular V closer to the 
original instruments that could be 
configured by Moog Music upon order.  
 
Improvements have also been made to the 
audio, making use of the evolution of our 
TAE® technology which has seen 
improvements during the year. We have 
answered a frequent request in relation to 
Audio-in so that you can now use the Moog 
Modular V filters or sequencer on an 
external source.  
 
Of course, we have also developed new 
modules, six to be precise. The 928 
(Sample and Hold) and 912 (Envelope 
Follower) were popular demands and can 
be found in this new build.  
 
Also added are very rare modules such as 
the 1630 Bode Frequency Shifter – around 
a dozen models produced - or completely 
new modules such as the Formants Filter  
 
Last but not least is the addition of 200 new 
presets to this version. They make use of 
the new options offered by the Moog 
Modular V, and will be a great starting point 
for those who wish to discover this new 
version. Go to the last part of Chapter 7 if 
you wish to jump into using the new 
modules offered.  
 
Hoping that you enjoy this evolution, we 
wish you the greatest pleasure in your use 
of the Moog Modular V 2.5  
 
 

The Arturia team 
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1 INTRODUCTION 

 

1.1 THE BIRTH OF MODULAR MOOG SYSTEMS 

Robert A. Moog was born in May 1934 in New York. A passionate for music (he took piano 
lessons for 12 years), he was introduced to electronics by his father, an engineer in this 
domain. During his adolescence, he discovered the Thereminvox plan, invented during the 30’s 
by a Russian engineer, Leon Theremin (or more exactly Lev Sergeivitch Termen). Seduced by 
this instrument with its never before heard sounds, he began to produce his own models and 
founded his own company in 1954.  
 
Frequenting musical professionals, and in particular electronic and concrete music, R. Moog 
realized that there was a real demand for electronic instruments of a higher quality.  
 
One of the first clients to come to Robert Moog, the professor of music Herbert A. Deutsch, 
asks him to listen to a song he had composed. Moog is immediately convinced and they decide 
to associate their work. Their co-operation produced the first VCO.  
 
In 1964, the first prototype of a Moog synthesizer was produced. It was a modular system with 
a voltage controlled filter (VCF), an envelope generator, a white noise generator, a trigger and 
two keyboards each with a generator module (sawtooth, triangle and impulsion) as well as a 
voltage controlled amplifier module (VCA).  
 

 
The first modular Moog system (1964) (Courtesy of Roger Luther, MoogArchives.com) 

 
Then other musicians helped Robert Moog in creating different modules:  
Walter Carlos (who later became Wendy) helped for elaboration of a sequencer. He also 
pushed Bob Moog to lend his name to his machines.  
Vladimir Ussachevsky, who was one of the professors of de W. Carlos, specified the 4 parts of 
the envelope generator (ADSR), allowing the accomplishment of the VCA and gave him the 
idea for the envelope follower.  
Gustave Ciamaga helped with the creation of the first tension controlled low-pass filter. 
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A second prototype, regrouping the all of the new modules, was built during the summer of 
1964 and was presented during the AES show (Audio Engineering Society), where Moog 
worked from an unused stand. This new product generated a huge amount of interest, but 
Moog did not yet realize the commercial punch of his machines. Two or three orders were 
obtained at AES and kept Moog busy for several months. In 1965, after the success at the 
show, Moog decided to release the 900 series for commercial sale.  
 

 
The R.A. Moog Company at Trumansburg, NY (Courtesy of Roger Luther, MoogArchives.com) 

 
The first client to buy the full Moog system was choreographer Alwin Nikolais. Also among the 
first users were composers Eric Siday and Chris Swansen. The first commercial uses of the 
Moog synthesizers were done in advertising. They were also used for jingles and in recording 
studios.  
 
In 1967, Bob decided to release different machines each with a certain number of modules. 
This marked the birth of modular systems I, II and III. This same year, Paul Beaver for the 
first time used a modular Moog system on a record.  
 

 
The modular system III (1967) (Courtesy of Roger Luther, MoogArchives.com) 

 
In 1968, worldwide recognition came with the success of “Switched-On Bach” by W. Carlos. 
This album, where classical music is played on a Moog, sold over one million copies as it was 
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bought both by classical music fans (it was in the American “Classical” charts for 94 weeks) 
and fans of pop. It won three Grammy awards.  

 
 

“Switched-On Bach” by W. Carlos 

 
A little later, Keith Emerson, keyboard player for the groups Nice and ELP (Emerson, Lake and 
Palmer), was he himself to become an ambassador for Moog synths. He was one of the first to 
play a Moog modular on stage during a tour (A 3C system). Jan Hammer was also one of the 
first users of Moog systems. Big groups like Tangerine Dream, the Beatles or the Rolling 
Stones, would also become modular Moog owners.  
 

 
The 3C modular system (1969) (Courtesy of Roger Luther, MoogArchives.com) 

 
In 1969-70, the company which now has around forty employees was building up to three 
modulars per week and the order book was always full.  
The modular had 5 years of high sales, and sold around 200 models in the United States.  
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Construction and testing of a modular Moog (Courtesy of Roger Luther, MoogArchives.com) 

 
In 1969, Bob Moog received demands for a more compact instrument that could be 
transported more easily, directed more to stage than studio. With the help of an engineer from 
Berkley, Jim Scott, and the advice from numerous musicians he was about to create another 
mythic synth: the Minimoog… 
 

 
System 55, the last version of the Moog modular (1974) 

(Courtesy of Roger Luther, MoogArchives.com) 

 

1.2 A MODULAR SYNTHESIZER, WHY? 

Why create a modular synthesizer, that is to say comprised of independent modules that we 
must connect ourselves, sometimes with difficulty, before obtaining a sound? 
 
The answer, as you can imagine, is very simple: the modularity brings immense possibilities 
for the creation of sound.  
 
To convince you, lets look at some basic concepts. 
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Sound synthesis is essentially based on the use of generators and filters. From these 
components, the sound designer must create sounds that can be used by musicians. To 
succeed, the different parameters that we have access to (height of note, filter cut-off 
frequency, output volume, wave form…) must evolve in time. And for this, we must link 
different modules between each other. 
 
Let’s take an example: an oscillator, which has inputs to modulate each of its parameters. 
Let’s connect the output of an envelope generator to the oscillator frequency modulation input, 
and there we get a signal depending on the use of a keyboard. Now we’ll connect a low 
frequency generator to the impulse width modulation input and here we have the waveform, 
which will evolve in time. 
 
But why not have internal cables, fixed from the start? 
 
Here again, another example will help. Let’s take an envelope and two oscillators. The latter 
possess three modulation inputs: a frequency modulation, an impulse width modulation and a 
volume modulation. 
Effecting every combination with fixed connections would oblige us to have six independent 
buttons for the modulation of the parameters. 
 
If we now take 9 oscillators, 6 envelopes, a modulation wheel and a velocity setting, we would 
need… 216 setting buttons. 
 
What can we therefore say for the Moog Modular V, which on top of this has three filters, a 
noise generator, a sequencer and two control pads.  
 
Connections in a modular synthesizer can sometimes seem difficult, but the often-unexpected 
results, are always a source of great musical inspiration.  
 
Either way, don’t worry, the presets created by experienced musicians will allow you, if 
necessary, a gentle introduction to the art of sound creation. 
 
This new version presents new modules and a notable improvement to the sound quality and 
synthesis possibilities. As was the case with the previous versions, it remains faithful to the 
original Moog Modulars and offers the possibility to organize the arrangement of certain 
modules. Ergonomically this version remains very close to the previous so as not to loose time 
learning the different functions again. 
 

1.3 A BETTER EMULATION THANKS TO TAE® 

TAE® - standing for True Analog Emulation - is a new technology dedicated to the digital 
reproduction of analog circuits. 
 
When implemented in software code, TAE’s algorithms guaranty the respect of hardware 
specifications. This is why your Moog Modular V offers an unparalleled quality of sound.  
 
In detail, TAE means: 

1.3.1 Aliasing-free oscillators:  

Standard digital synthesizers produce aliasing in high frequencies, and when using Pulse Width 
Modulation or FM. 
 
TAE® allows the production of totally aliasing-free oscillators in all contexts (PWM, FM…), and 
at no extra CPU cost. 
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Linear frequency spectrum of an existing well-known software synthesizer 

 

 

Linear frequency spectrum of the Moog Modular V oscillator made with TAE® 

 

1.3.2 Better reproduction of analog wave forms: 

Original analog oscillators used condensers’ unloading to produce common wave shapes (saw 
tooth, triangle, square). This means that waveforms were slightly curved. TAE® allows the 
reproduction of Condenser’s Unload. 
 

 

Temporal representation of a waveform on a Modular Moog 55 

 

Aliasing 
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Temporal representation of the waveform of an existing Moog-like software synthesizer 

 

 

Temporal representation of the Moog Modular V waveform thanks to TAE 

 
In addition, original analog oscillators were unstable. Actually, their wave shape was always 
slightly different from one period to another. In addition, due to analog hardware sensitivities, 
new period trigger times varied with the temperature and other environmental conditions.  
 
TAE simulates the instability of oscillators, helping to create warmer and fatter sounds. 
 

1.3.3 Better reproduction of analog filters 

TAE allows the emulation of analog-designed filters in a much more precise way than any 
existing digital filter. In particular, TAE has managed to reproduce the legendary Moog 24dB 
low-pass resonant filter with great respect towards the original. 
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Standard 24 dB digital low 
pass resonance filter for a 
typical software 
synthesizer 
 
 
 
 
 
 
 
Very selective 24 dB 
resonance filter of the  
MiniMoog 
 
 
 
 
TAE made Moog Modular 
V resonance filter: First 24 
dB resonance filter to be 
that selective 

 

Comparative response filters 

 

1.3.4 Implementation of soft clipping 

In analog synthesizers, the resonant filter uses a current limiting function, preventing the 
signal from being too loud (soft clipping). 
 
TAE reproduces this current limiting function, making the sound more natural. It also allows 
filters to enter self-oscillation like original hardware synthesizers do. 
 

 

Low-pass resonant filter Input Output 

Current limiting 
emulation 
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2 INSTALLATION 

 

2.1 WINDOWS INSTALLATION (XP, VISTA, 7) 

Insert the CD-ROM in the drive. Explore the CD-ROM content; double-click on the “Moog 
Modular V 2 Setup PC.exe” icon 
 
At the first step in the installation, choose the folder to install the Moog Modular V. It will be 
installed by default in C:\Program Files\Arturia\Moog Modular V 2. You can change the 

destination with the Browse button. 
 

 
Choice of installation folder 

 
The Moog Modular V2.5 will be installed as a standalone application. The following step allows 
you to install the Moog Modular V2.5 as a plug-in. To do this, choose the protocol(s) that you 
use (VST, RTAS). For more information on these protocols, look at chapter 8. 
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Choosing the protocols 

 
For the VST and RTAS protocols, you need to choose the installation folder to allow the host 
application to use the Moog Modular V2.5 as a plug-in. If you do not know how to make this 
choice, go to chapter 9. 

 

Installation folder choice for the VST plug-in  

 
The installation program now has enough information to complete the installation. When the 
installation process is completed, please proceed to authorization step (Chapter 3).  
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2.2 INSTALLATION MACOS X 

Insert the CD-ROM into the drive. Explore the content of the CD-ROM, then double click  
on the icon named “Moog Modular V2.5 Setup”.   
Follow these steps:   
- Read and accept the End User License Agreement,   
- Select a destination.   
When prompted, enter the administrator name and password of your computer in the  
authentification window.  

 

 

Authentification window 

 
The Moog Modular V2.5 will next be installed as a standalone application, but also as VST, AU 
and RTAS plug-ins.   
  
The installation program now has enough information to complete the installation. When  
the installation process is completed, please proceed to authorization step (Chapter 3).  
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3 AUTHORIZATION 

 
Now your Moog Modular V 2.5 has been installed, you have to authorize the synthesizer. 
 
Earlier versions used an “original CD + license number” protection scheme, however, the Moog 
Modular V 2.5 uses the Soft-eLicenser full-software solution. Avoiding the use of a USB port by 
default, this system allows using the synthesizer on one machine which must be connected to 
the Internet during the authorization process. 
 

 To transfer your license on another computer, or simply use the Moog Modular V2.5 on several computers (one 

instance at a time), you will need: 

• one USB-eLicenser hardware dongle (sold separately, also used by many other software vendors); 

• follow the License Transfer Wizard inside the eLicenser Control Center. 

This transfer, requiring a valid Internet connection, can be done in both ways: 

• from Soft-eLicenser to USB-eLicenser; 

• from USB-eLicenser to Soft-eLicenser. 

Please check the eLicenser documentation installed on your computer for further details. 

 
Connect your computer to the Internet, and then launch the eLicenser Control Center. This 
application has been automatically installed on your computer; depending on your computer 
operating system it is accessible through: 
� Windows: Start > Programs > eLicenser > eLicenser Control Center 
� Mac OS X:  Finder > Applications > eLicenser Control Center 
 

 The screenshots below have been taken on a Mac OS X operating system; however the process is strictly identical 

under a Windows XP/Vista/7 environment. The same functions apply, only the graphical user interface slightly differs. 

 
In the eLicenser Control Center main window you should see a Soft-eLicenser (SeL) virtual 
dongle created onto your computer. 
 

 
License Control Center main window, showing an empty Soft-eLicenser. 

 
� In the License Control Center menu, go to Actions > Enter Activation Code. 
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� When prompted, enter the 32-digit Activation Code; this code is written on the little 

plastic card attached to your User’s Manual.  
 

� Click on Continue to activate your software. 
 

 
Enter the activation code 

 
The License Control Center is now ready to download the software license that will allow you to 
use the Moog Modular. Click on Continue, the progress bar should advance until download 
completion. A popup window will confirm, just click Close, then Finish. 
 

 
License download confirmation window 

 
� Now the main License Control Center window should show your Moog Modular V license 

installed and activated. 
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License is installed and activated 

 
� It’s now time to launch the Moog Modular Vsynthesizer. 
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4 QUICK START 

 
This section of the manual will allow you to learn the general principles of how the Moog 
Modular V works. This will be a presentation of the different views available, the modules and 
signals used while using the program for the first time. You will find a detailed and precise 
description of all of the modules and controllers visible on the screen in the following chapters.  
 
The Sound Design chapter located in the second half of this manual is also recommended for 
users who have never used a modular system before, and who wish to learn the fundamentals 
of this domain. 
 

4.1 THE 4 SECTIONS OF THE MOOG MODULAR V 

The Moog Modular V is made up of four distinct sections:  
� The first at the top holds a sequencer and a certain number of effects. 
� The second, underneath, is for working on the sound synthesis with the different inter-

connectable modules. 
� The third is an extension allowing us to regroup the different external input-outputs and 

some internal cables. 
� The fourth holds the virtual keyboard, as well as a section dedicated to the key follows 

and essential controllers.  
 
It is possible to keep only the fourth section on the screen, by clicking on the Keyb icon on the 
toolbar.  
 
When the whole synthesizer is displayed, we can move it vertically by using the icons that 
represent the different views or by clicking and dragging the background.  
 

 
 

4.1.1 The synthesis section 

Visible as soon as the synthesizer is opened, it is made up of two parts (cabinets). It integrates 
the 33 modules necessary for the creation of sounds. The modules in the upper part can be 
exchanged via the menu that appears when their name has been clicked. It is thus possible to 
replace an envelope with a ring modulator, a filter with a frequency translator. 
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The first section composed of 2 cabinets 

 

4.1.2  The other three sections 

The first, situated at the top of the synthesizer, contains the step sequencer and 4 effects (the 
right hand effect can be either a chorus or phaser). The two others are found under the 
synthesis section. One is a small extension containing the internal cables, while the other holds 
the virtual keyboard and its assignable controllers.  
 

 

The second section composed of a sequencer and effects 
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The virtual keyboard and extensions section  

 

4.1.3 Reduced view of the keyboard and the real time controllers 

You also have the possibility to only keep the keyboard and its assignable controllers visible on 
the screen. The goal is to have quick access to all of the important real time controllers and 
sound presets all while having a smaller work surface.  
 

 

Reduced view of the keyboard 

 

4.2 USING PRESETS 

Using presets is one of the main areas of evolution of the Moog Modular V when compared to 
its predecessor, which did not save sound. 
 
A preset contains all of the inter module connection information and the different controller 
settings needed to reproduce an identical sound. 
 
To make you familiar with the different sounds contained in the Moog Modular V, we will select 
the preset Bass1. 
 

� For this, click on the button above the LCD screen indicating “C.Engel” (this screen 
presents the name of the bank currently being used). By clicking, you will see a 
scrolling menu appear which will indicate a list of the available banks. Choose the bank 
named “JM.Blanchet”. Now click on the button above the second LCD screen presenting 
the word “Leads” (this screen indicates the name of the sub-bank currently being 
used). Choose “Basses”. Do the same thing on the 3rd LCD screen and select “Bass1”. 
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Select the preset bass1 

 

 The presets, located on the Moog Modular V toolbar, are classed in “banks” and “sub-banks”. Each bank contains a 

certain number of sub-banks, which determine in general a type of sound: sub-bank “basses”, sub-bank “sound 

effects”, etc. Each sub-bank contains a certain number of presets.  

The Moog Modular V is supplied with 800 additional “factory” sound banks, which allow you to get acquainted with 

more sounds and sequences of the synthesizer. A bank called “user” offers a selection of presets allowing you to begin 

from a base configuration to start the programming of a sound (for example the sound “1 oscillator” comes with an 

oscillator pre-connected to the first filter – a low pass-, the signal then goes to VCA1).    

 
� Now let’s modify this preset To do this, we will start with a simple manipulation. Modify 

the cut-off frequency of filter1, the first module on the top left of the synthesizer (a 
low-pass resonant filter). Turn the “frequency” button in the direction of the hands of a 
watch. The sound becomes increasingly “brilliant”. Set this knob as it pleases you. 

 

 
The setting of filter1 cut-off frequency 

 
By performing this first setting, you have already modified the preset “Bass1”. We will now 
save the sound that you have created. 
 

� To save this newly created sound among the user presets, click on the Save icon in the 
toolbar: the sound setting being used will be saved in the currently selected preset.  

 
If the current preset is a “factory” preset, the factory preset will not be replaced (the “save” 
icon will not be available). To choose another destination for this sound, click on the “Save as” 
icon and choose the location. Select, for example, “new” in the choice of banks (“bank”). 2 
new bank and sub bank (“Sub bank”) locations and a new preset are created the names 
“default0”, “default0” and “default0” will appear in their respective displays (if other default 
names exist, then the number is incremented). Click on each one to modify the name of the 3. 
 

 

Saving a preset 
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4.3 MODULAR SYNTHESIZER 

The modular synthesizer cabinet contains 28 modules, which will help you to create an infinite 
variety of sounds. These 28 modules can be broken down into different categories and will be 
connected by cables. 
 

4.3.1 First connections 

Let’s see how to quickly create an evolving polyphonic sound: 
 

� To correctly understand the programming of the Moog Modular V, select the “Blank_ 
synth” preset in the “User” / “Blank” bank. It holds no connections and thus produces 
no sound.  

 
� Take the “saw” output of oscillator2 and connect it to the audio input of filter1 (low-

pass 24 dB). To do this click on the output jack of the waveform (a cable will appear) 
and drag it to the filter1 input “in”. Once the cable has been released in the input jack, 
the connection has been made. 

 
�  

 
 

Connection between oscillator 1 and filter1 

 

 You can also create a connection by choosing the cable destination with a menu with a right click (or shift click) on 

the output jack. 

To delete a cable, click on it, it will then appear in a clearer color to show that it is selected. Press the “DEL” key on 

the keyboard to remove the connection. 

 
� Now connect the audio output of this filter to the VCA1 (voltage controlled amplifier) 

audio input. Once the connection has been made, you can “play the sound” on your 
MIDI keyboard or the virtual keyboard offered by the Moog Modular V. 
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Connection of the filter1 audio output to the VCA1 audio input 

 
Once you have obtained a basic sound, you can add elements to enrich the sound. 
 

� Take the “saw” output of oscillator2 and connect it to the audio input of filter2. 
 

 

Connection between oscillator 2 and filter2 
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� Next connect the audio output of this filter to the VCA2 audio input. 
 

 
 

Connection of the VCA2 audio input  

 
� Slightly detune the pitch of the second oscillator by turning the “frequency” button. You 

will obtain a sound that is more “alive” and “thick”.  
 

 
 

Detune the pitch of the second oscillator 

 
� Continue to complete the sound with modifications acting on the 2 filters. For this, 

connect the “sin” output of LFO1 (placed next to the 3 filter modules) to one of the 
modulation inputs of filter1. 

 
 

The LFO1 module 
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� Turn the jack ring (transformed to a knob after the cable connection) to change the 
level of modulation. If you turn to the right, the modulation will be positive, and if you 
turn to the left negative.  

 

Turn the jack ring 

On the original Moog Modular, it was not possible to directly set the value of the modulation input signal. To do this 

we needed to go through controllable VCAs or dampening modules of which there were not very many. On the virtual 

synthesizer, it is possible to control the input modulation level (once the connections have been made) by turning the 

ring of the connected jack – this ring will “transform” virtually into a knob.  

 
� You can repeat these operations with filter2 (you can use the audio outputs as many 

times as you like, one of the miracles of computers.)  
 

� To obtain a different modulation to the one applied on filter1 (all while remaining 
synchronous), turn the jack ring of filter2 in the opposite direction of what you had 
previously done with filter1. 

 
� Set the attack of the output VCA envelopes to 10h so that the sound will arrive 

progressively when you press keys on your MIDI keyboard. 
 

 

The Attack (A) settings for the output VCS envelopes 

 
� To finish, turn the panoramic knobs on the 2 output VCAs, the first to the left and the 

second to the right. You will obtain a very natural stereo without the use of external 
effects. 

 
� Don’t forget to save your preset in a bank to your name and a sub-bank with the name 

“Pads”. Then, enter the preset name “Stereo_Pad”. 
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The final patch 

 

4.3.2 Description of the synthesis section modules 

 

4.3.2.1 The oscillators 

They are 9 in total, regrouped in threes like the original Moog:  
1 “Driver” oscillator: allow the management of the frequency and impulse width of the 3 
“slave” oscillators. These 3 “slave” oscillators can be tuned and modulated separately. They 
deliver 4 waveforms that can be simultaneously used. 
 

 
 

An oscillator bank (1 “driver” and 3 “slave oscillators”)  

 

4.3.2.2 1 white and pink noise generator 

To the oscillators previously described we add a white or pink noise generator. It is accessible 
in the form of 4 outputs. This mode also has two 6 dB/oct. filters: a low-pass (LPF) and a high-
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pass (HPF). With these, you can, for example, change the nature of the noise to make it more 
or less brilliant  
 

 
 

White and pink noise generator 

 

4.3.2.3 The filters 

The Moog Modular V possesses 3 filters. Each of these filters can be chosen between 4 types:  
� Low pass 24 dB/octave (type 904A) 
� High pass 24 dB/octave (type 904B) 
� Band pass and band reject 24 dB/octave (type 904C) 
� Multi-modes 12 dB/octave (low-pass, high-pass, band pass, band reject, bell, shelf). 

The type change is done by clicking on the title of the filter type and by selecting the desired 
filter in the proposed menu. 
 

 
 

The 4 filter types 

 

4.3.2.4 The auxiliary ADSR modulation envelopes 

They are 6 in total, allowing the evolution of the sound in time. 
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The auxiliary envelope 

 

4.3.2.5 Dual trigger delay 

A module with two trigger delays allows the management of the signals used to trigger 
envelopes and sequencer. 
 

 
 

The trigger delays  

 

4.3.2.6 The LFOs 

Two low frequency oscillator modules (“Low Frequency Oscillator”) are used to create a cyclic 
modulation on one (or several) sound setting. 
 

 The “slave” oscillators can also be used as LFOs when they are brought to low frequency positions when they are 

switched in low frequencies (“low freq”). This gives a total availability of 11 LFO modules. 
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The LFO module 

 

4.3.2.7 The VCAs 

There are two output amplifiers (VCA), each with an individual envelope. We can imagine 
placing a VCA on the right and one on the left to create a stereo effect. 
 

 

An output VCA 

 

4.3.2.8 Mixers and amplifiers 

16 independent amplifiers are at your disposal. Each has its own volume setting with the 
rotating “level” button and amplitude modulation input.  
These amplifiers can be regrouped to create mixers. To regroup two amplifiers simply click on 
the “link” button that separates them.  
When two amplifiers are regrouped, the output signal of the first corresponds to the sum of the 
output signals of the two amplifiers, while the second remains as it was before the regrouping.  
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The mixer VCAs  

 

4.4 THE OTHER SECTIONS 

4.4.1 The sequencer 

This module conforms to the original Moog while simplifying the programming with internal 
connections. 
It is with this module that you can create melodic sequences or sequences applied to a 
parameter (a sequence line applied to the opening of the frequency can, for example, be very 
efficient). 
 

 The sequencer has 3 sections:  

Low frequency oscillator allows the cadence of the passage from one sequence to another. Its speed can be set 

statically with the “frequency” button and dynamically with the modulation input on the first page. Two buttons, “on” 

and “off” respectively start and stop this generator.  

Eight step sequence manager. Each step defines 3 levels of output modulations, with 3 rotating buttons. The manager 

moves from one step to another on every impulse from the low frequency generator. The 3 lines of sequence can also 

be chained to create a longer sequence (up to 24 steps) 

The output controller. It allows the management of the 4 modulation outputs in function with the current step. The 

first 3 outputs take their values from the rotating buttons of the current step (on the corresponding line), eventually 

with a configurable soothing through the “smooth” buttons. The fourth output, for which the smoothing can also be set 

through the “smooth” button, is managed in the following manner. It takes the value from one of the 3 outputs in 

function with the current step and the type of progression specified with the “Chain” selector: This allows the linking 

sequences to create variations. For example to link lines 1,2 and 3 to obtain a 24 step on the same controller.  

 

 
The sequencer sections 
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To create an 8-step note sequence from the sound you have previously edited (“bass1”):   
 

� Assign “Driver” oscillators to one of the 4 sequence lines. For this, on the sequencer 
screen click a few times on the corresponding LCD display on the bottom of the 
“Driver”, (on the right) to select the sequence line. “L1, 2, 3 or 4” 

 
 

Validation of a sequence line on the “Driver” oscillator 

 
� On the 2 VCAs, click on the “trigg out” plug to apply a “trigg”, corresponding to the 

sequencer output (“Sequencer trigger”), so that it can be taken into account and freely 
react, without the help of a keyboard trigger. The sequencer will work on its own when 
you start it. 

 

 
Apply a sequencer output to the VCA (here VCA2) 

 
� Now go to the second screen and click on the “On” button situated in the “Oscillator” of 

the sequencer. This will play the sequence in a loop. 
 

 



36 ARTURIA – MOOG MODULAR V 2.5 – USER’S MANUAL 

Click on “on” to start the sequencer  

 
� Set the pitch of each note in turning the knobs of the sequence row applied to the 

Driver oscillator. 
 

 
 

Setting of the values corresponding to the pitch of the oscillators 

 
� Also set the length of the notes with the “length” knob 

 

 
Set the length of each note  

 
� You can add a little portamento by turning the “smooth” knob on the right of the line 

corresponding to your sequence. 
 

 
 

turning the “smooth” knob 

 
� It is also very easy to rhythmically enrich the sequence by linking (“link” button) or 

repeating certain notes (select the number of repetitions by clicking several times in the 
LCD display beside the “repeat” button and click on the latter to confirm the repetition 
of the notes) 
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Click on the “repeat” button  

 
� If you wish to add more steps to your sequence, 16 for example, select “L4” in the LCD 

display below the oscillator “Driver” of the sequencer. Now select “L12” in the LCD 
display on the right of the sequencer (“chain”). To have 24 steps, select “L123”.  

 

 
 

To have 24 steps, select “L123” 

 

4.4.2 The effects  

The second section also has three effects, which will allow you to bring more color and space 
to your sound or sequence. 
These are on the right of the sequencer; the chorus can be replaced by a phaser. 
 

 
 

The 3 effect modules 
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� Resonant filter bank (Fixed Filter bank): affects equalization to the outgoing signal 
coming from the 2 output amplifiers in function with the state of the interrupters 
“VCA1” and “VCA2”. This equalization is done with the help of resonant filters with 12 
band pass filters,- each of the bands has a level (positive or negative) and bandwidth 
setting. This module also possesses a low-pass filter (80Hz) and a fixed high-pass 
(12KHz). 

� Chorus: the chorus module allows a frequency modulation where the rapidity can be 
set with the rotating “rate” button, the amplitude with the rotating “amount” button, 
and the width by the rotating “delay” button.  

� Stereo delay (Dual Delay): allows the repetition of the incoming signal independently 
for the left and right, which explains the presence of 2 control columns, one for each 
side.  

 

4.4.2.1 The fixed filter bank 

 

The fixed filter bank 

 
� To add a complex filtering with the fixed filter bank, start by activating the 2 switches 

“VCA1” and “VCA2”. This will connect the effect to the two VCA outputs. 
 

� Modify the filter frequency bands by turning the gain knobs. This will increase (to the 
right) or reduce (to the left) the gain corresponding to these frequencies. 

 

 
 

Increase the gain of the chosen frequency 

� You can refine the equalization with the bandwidth knob corresponding to the frequency 
you have chosen. If you turn the knob (underneath the frequency gain setting) to the 
right, you will reduce the bandwidth around the central frequency to make the 
equalization setting increasingly precise. On the other hand, by turning it to the right, 
you will increase the bandwidth, making the equalization less precise.  
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Set the frequency band width 

 
� If you have applied several strong equalizations, (with very pronounced band 

reductions for example) you run the risk of having a consequential decrease in volume. 
To regain a normal volume level, turn the “gain” knob (on the bottom right of the filter 
bank) towards the right. Watch out for saturation. 

 

 
 

Filter bank output gain 

 

 Thanks to MIDI, it is possible to record frequency gain and band width knob movement (with the MIDI sequencer). 

This will make the sound “speak” or evolve in a manner that synthesizer filters cannot. Try it for yourself.  

 

4.4.2.2 The “Dual delay”  

You can also enrich your sound and give it more stereo space; for this, add stereo delay. 
 

 
 

The delay effect 

 
As is the case for all of the Moog Modular V effects, the Dual Delay works in “real” stereo in the 
sense that it possesses an independent input and output for both sides.   
 

� To activate the delay effect, begin by triggering the 2 “VCA1” and “VCA2” switches. This 
will commute the action of the effect to the 2 audio outputs of the sequencer.  

 

 It is also possible to keep a part of the sound effect free by deactivating one of the two VCA switches. This can be 

very interesting when using the synthesizer for multiple tones (for example, a bass sound played on the keyboard 

coming out to the VCA1 which is set without effect and an arpeggio sound played by the sequencer which will be 

directed to the VCA2 where the effects will be activated) 
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� On the delay, set the time between repetitions (“time” buttons) for each side of the 

stereo (“L” left and “R” Right)  
If you wish to get a stereo echo, apply a different setting for the repetition of the left and 
right. So that the delay is synchronous, activate the “Sync” switch at the top of the module. 
 

 
 

Set the time between repetitions 

 
� To control the repetitions reinsertion intensity, increase or decrease the value on the 2  

“feedbacks”. Do the same thing for the “crossed” repetitions (one on the left and one 
on the right “Cross feedback” buttons).  

 

 
 

The “feedback” settings 

 
� Now, set the balance between the sound without effect (“dry” knob) and the delay 

return (“wet” knob). 
 

 
 

The “dry” and “wet” settings 

 

4.4.2.3 The chorus 

Chorus is used to create a doubling effect on a sound; this will give it more width and 
“thickness”. If you accentuate the effect intensity, you will obtain a very discordant sound. 
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The chorus effect 

 
� Like the other effects, activate the VCA1 and VCA2 switches to commute the action of 

the effect to the 2 audio outputs of the synthesizer.  
 

� To correctly hear the different modulation depths, simply increase the value of the 
“amount” knob. The higher the value, the more discordant the sound. 

 

 
 

The “amount” parameter 

 
� Set the modulation rate by turning the “rate” knob. The faster the speed, the quicker 

the detuning.  
 

� You can also widen the stereo action field by increasing the value of the “stereo width” 
knob. 

 

 
 

The stereo settings 

 

 With chorus, it is also possible to obtain the stereo sweeping of the sound by decreasing the “amount” knob and 

working only on the value of the “stereo width” (depth) and “stereo rate” (oscillation speed) knobs. This will create an 

“auto pan” effect. The effect will be even more present if you lower the level of the signal without effect (“Dry”), 

leaving only the effect return (“wet”).  

 

4.5 THE VIRTUAL KEYBOARD AND ITS REAL TIME CONTROLLERS 

A virtual keyboard is used to control the synthesizer notes and add supplementary real time 
modulation settings. It can either be coupled with the sequencer section and the effects or 
used alone to save space.   
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The keyboard and its controllers 

4.5.1 The keyboard  

The virtual keyboard situated on the bottom of the second screen, allows the quick testing of 
the sounds of the presets, or the sound that you are editing, and this without the need for an 
external MIDI keyboard. 
 
The pitch bend and modulation dials are also available for height (affected to the oscillator or 
filters) and modulation settings (affected to any of the synthesizers modulation sources). The 
connections are made by cables on the first screen. 

4.5.2 The keyboard controllers 

The different settings concerning the real time controllers affected to the keyboard can be 
found on the left, above the virtual keyboard.  
 
Here you will find all of the settings applied to the 4 key followers, the pitch bend and 
modulation wheels, as well as velocity and aftertouch.   
 

� Before using them, go back to the module section to define the parameters, which will 
be modulated by these controllers. The connection jacks are found underneath the 
modular synthesizer section. 

 

 

The controller connection jacks 

 
� For this example, let’s take the “stereo_pad” sound created earlier. Connect the output 

of the modulation dial “mod” (at the bottom of this section) to the filter1 cut-off 
frequency modulation input. Set the amount parameter of this modulation to your liking 
so that it can be taken into account by the wheel. Now test by turning the dial on your 
MIDI keyboard or the virtual keyboard. 
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Connections for modulation and velocity outputs on the frequency modulation of filters 1 and 2 

 
� Now do the same thing, connecting the velocity output (“vel”) to the filter2 cut-off 

frequency modulation input. To test velocity settings, use your MIDI keyboard, the 
virtual keyboard naturally is not sensitive to velocity. 

 
4 independent key follows: apply a continuous change of a modulation parameter in relation to the scale of the 

keyboard (tune the oscillators for example).  

The pitch bend and modulation dials: add a modulation to the parameter(s) connected to its source. 

The portamento (“Glide”): adds a frequency smoothing (portamento) between 2 notes. 

The velocity: adds a modulation to the parameters, which are affected by the force with which the key is played on 

the MIDI keyboard. 

Aftertouch: adds a modulation to the parameters connected to its source by a variation in the force used on the keys 

of the MIDI keyboard.  

 
You can continue the experience with one of the four key follow outputs.  
 
There are two means of connecting a key follow modulation:  

• The simplest and fastest is the automatic connection through the LCD displays situated on the “drivers” oscillators 

and on the 3 filters. This method produces a perfect pitch for all the scale of the keyboard.. 

• A cable connection gives you the possibility to have finer but more complex settings. We recommend this type of 

modulation for non “tuned” parameters, like an impulse width modulation (“PWM”) on the “driver” oscillators, or 

simply the volume of a VCA. 

 

 
 

The key follow settings 

 

4.5.3 The play modes 

The play modes provide a choice between the different manners of playing the MIDI keyboard. 
These different settings are situated underneath the pitch bend settings. 
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The play mode parameters 

 
� The “mono/unison/poly” switch lets you choose: a monophonic playing mode (a single 

note played at a time, chords cannot be produced in this mode. This mode corresponds 
to the mode used in the original Moog Modular), a polyphonic mode (several notes can 
be played at the same time to form a chord). The maximum number of voices is 
displayed in the corresponding window. The unison mode is identical to the 
monophonic, but there are as many voices played at the same time as the polyphonic 
voices. 

 
� The “legato” button, active when the synthesizer is in monophonic mode, allows the 

activation of the portamento – or “glide” in English – freely on all of the notes when it is 
active. If you wish to only use portamento on notes that are linked, deactivate the 
legato mode. 

 
� The “retrig” button, also active when the synthesizer is in monophonic mode, allows the 

systematic re-triggering of the envelopes, even if you link the notes in your playing 
sequence. If, on the other hand, you don’t wish to re-trigger the envelopes when 2 
notes are linked, leave the button raised. 

 
� When the synthesizer is in polyphonic mode, 1 LCD display on the right of the switch 

allows the setting of the maximum number of notes that can be played simultaneously 
(“poly” screen. This setting can limit the CPU load provoked by each simultaneous note 
played on your MIDI keyboard or sequencer. 

 
� To activate the portamento mode, click on the “ON” button under the portamento 

intensity knob (“glide”), situated next to the 2 dials, on the right of the virtual 
keyboard. 

 

 

The portamento settings 

 

4.5.4 The sound design controllers 

Three control surfaces allow the modulation of the sound parameters in a fast and intuitive 
manner:  
� Eight sliders that allow control of the envelopes of the output VCA 1 and 2  
� Two 2D controllers that can be assigned to the parameters of your choice  
� Three knobs for the setting of cut-off frequency off the 3 filters. 
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4.5.4.1 The envelope control sliders 

The two envelopes are directly linked to those of the VCAs: if you modify one of the 
parameters (Attack, Decay, Sustain or Release – the 2 slope parameters are not represented 
here for simplicity), the modification will automatically and identically be taken to the 
synthesizer. The opposite is also true. 
 

4.5.4.2 The 2D Pads 

Now try to use one of the 2D controllers to modulate the cut-off frequency (to X) and the 
resonance of filter1 (to Y).  
 

� For this, go back to the first screen to assign the 2 parameters to the 2D controller n°1 
outputs. The output connections can be found at the bottom of the synthesizer section 
(2D pad X /Y)  

 

 

The connection of modulation inputs of filter1 to the 2D controller 

 
� Return to the second screen and manipulate the 2D controller handle vertically (X) or 

horizontally (Y) to hear the result of the modulation. 
 

 

Using the 2D controller 

 

 To have access to these 2 modulation inputs on a low-pass resonant, it is essential to change the filter type. (the 

low-pass 24dB Moog does not possess a modulation input in the resonance.) Take the multimode filter and set it to 

low-pass mode, if it isn’t already the case. 

 

4.5.4.3 The filter cutoff frequency controller 

On the right of the 2D Pads you will find controls for the cutoff of the 3 filters modules 
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These will only be active if the filters are used in the current sound (a diode above each knob 
indicates if it is active)   
 
In our (“Stereo pad”) example the first two filters are used, you will notice that the first 2 
knobs are active. 
 
Simply try to change the settings and you will immediately hear the result on your sound. 
 

 
 

The three filter cutoff frequency controllers 

 
This chapter has given you a look at some of the many aspects of the Moog Modular V. Now 
try to go a little deeper using the rest of the documentation. You will find all of the details 
concerning the modules, the sequencer and the many different modes of use of the Moog 
Modular V. 
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5 THE INTERFACE 

5.1 USING THE PRESETS 

The presets memorize the Moog Modular V sounds. A preset contains all of the inter module 
connections and the different controller information necessary for the recreation of an identical 
sound. In the Moog Modular V, presets are classed in “banks” and “sub-banks”. Each bank 
contains a certain number of sub-banks, which determine a type of sound: sub-bank “basses”, 
sub-bank “sound effects”, etc. Each sub-bank contains a certain number of presets. 
 
The Moog Modular V comes with several “factory” sound banks. It is possible to create new 
“user” sound banks, each containing an unfixed number of sub-banks and presets. For 
security, the “factory” settings are not directly modifiable. It is, however, possible to modify a 
sound on the base of a factory preset and to record it to a “user” bank. 

5.1.1 Choice of bank, sub-bank, preset 

The banks, sub-banks and presets being currently used are always displayed in the synthesizer 
toolbar. 

 

Display of bank, sub-bank, and preset being used 

To choose a preset in the current sub-bank, click on the button on the left of the current 
preset, a drop-down menu appears with a list of presets from the same sub-bank. You can 
choose another preset in the menu by selecting the corresponding line. Once the preset has 
been chosen, you can play the new sound from your MIDI keyboard or sequencer. 

 

Choice of preset in the same sub-bank 

To choose a preset in the same main bank, but in a different sub-bank, click on the button on 
the left of the current sub-bank, a drop-down menu will appear with the list of sub-banks 
contained in the same main bank. Each sub-bank in the menu allows you to open a sub-menu 
containing its presets. A click on a preset lets you directly choose a preset in the new sub-
bank. 
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Choice of preset in another sub-bank 

To choose a preset in another main bank, click on the button on the left of the name of the 
current bank. A drop-down menu appears with the choice of the main banks that are available, 
and the sub-lists corresponding to the sub-banks defined in each main bank and the presets 
contained in each sub-bank. You can now freely choose a preset by clicking on its name. 

 

Choice of a preset in another main bank 

Once a preset has been changed (modification of a controller or connection), an asterisk 
appears next to its name in the tool bar. 

5.1.2 Creation of a bank, sub-bank, preset 

To create a new bank of sounds, click on the button on the left of the current bank. In the 
drop-down menu, select “New bank...” to create a new bank of sounds. You can then change 
the name of this bank by clicking on its name in the toolbar and typing the new name. 
 
To create a new sub-bank, again just click on the button on the left of the current sub-bank, 
and select “New sub bank...”. You can also change the name of the new sub-bank. 
 
Finally, to create a new preset, click on the button on the left of the name of the current preset 
and select “New preset...”. The new preset is created using the current Moog Modular V 
settings (controllers and connections). You can then work on the settings of the sound, and 
save it by clicking on the save button (see the next paragraph). You can also change the new 
preset name by clicking on its name. 

5.1.3 Saving a user preset 

To save your current settings under the current preset, click on the “Save” button on the Moog 
Modular V toolbar. 

 

 “Save” button on the toolbar 

If you want to save your preset under a different preset name, click on the “Save As” button in 
the toolbar. A drop-down menu will appear allowing the choice of either an existing preset (in 
this case, the preset contents will be replaced by the current setting), or to save your preset 
as a new preset (in this case, click on “New Preset…” in the sub-bank of your choice). 
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 “Save As” menu on the toolbar 

When you are working on a factory preset, which cannot be erased, clicking on the “Save” 
button will not replace the current factory setting, but will automatically open the “Save As” 
function to save the current setting as a user preset. 

5.1.4 Import / Export of a preset bank 

It is possible to import new preset banks created for the Moog Modular V. To import a new 
bank of presets, click on the preset bank import button in the toolbar: 

  

Preset bank import button on the toolbar 

 

When you click on this button, a dialog appears allowing the choice of Moog Modular V preset 
bank files (.AMB file type on PC, AMpB file type on Mac). Choose the file that you want to 
import, and click on “Open”. The new preset bank will automatically appear in the available 
banks. 
 
The Moog Modular V also offers the option to export your own sound banks to save them, use 
them on another machine, or share them with other users. It is possible to export a preset, a 
sub-bank, or a complete bank. To export a bank, sub-bank, or current preset, click on the 
export preset bank button on the toolbar: 

 

Current preset bank export button in the toolbar 

Select the type of export that you wish to perform (bank, sub-bank or preset) from the list and 
a window will appear prompting you to choose a destination folder and a name for the file you 
are about to export. 
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5.2 WORK PAGES 

The Moog Modular V offers 2 work pages. The first contains the 4 Moog Modular V sections, 
and the second holds the keyboard and shortcuts to the main controls. 

5.2.1 The complete view:  

 

Complete view 

The complete view contains all of the Moog Modular V sections. The full interface being too big 
to be displayed on a single screen, a scroll function allows you to move to the desired section.  
Simply click on the background of the synthesizer and drag the mouse up and down to move 
it.  

 

Work page selection buttons 

The ‘+’ and ‘-‘ buttons in the toolbar let you make the plug-in window bigger or smaller so as 
to adapt to your screen and resolution. The size will automatically be saved as a plug-in 
preference, and will be reused upon next launch. 

5.2.2 The reduced usage page 

The last shortcut button on the toolbar will take you to the reduced view. 
 
The reduced usage page contains the keyboard and the main controls. In this mode, the Moog 
Modular V is ready for immediate use of the presets of recorded sounds, with quick access to 
all of the major real-time controllers. The Moog Modular V window is smaller, but the 
sequencer and effects cannot be directly accessed.  
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Reduced usage page of the Moog Modular V 

5.3 USING CONTROLLERS 

5.3.1 Knobs 

The knobs are the most numerous controllers of your Moog Modular V. They can be controlled 
in different manners, which are explained in detail underneath: 

5.3.1.1 Mouse control (linear) 

Certain sequencers allow the knob mode of functioning to be changed with the mouse by 
moving to linear mode. In linear mode, the knob can be set only by moving the mouse 
vertically, without going around it. The linear mode can sometimes be simpler to use than the 
rotation mode. It can, at the same time, be less precise (the precision is limited by the number 
of vertical pixels contained in the screen on which the mouse movements are being 
evaluated). The linear mode can be accessed in the sequencer options. In Cubase™, for 
example, the choice can be accessed through the “Edit/Preferences” menu, and can be found 
in the “General” tab in the dialog window. 

5.3.1.2 Mouse control (higher linear precision) 

The Moog Modular V allows access to a higher level of precision when adjusting the knobs with 
the mouse, with the use of the right click (or shift + click). In this mode, the precision of 
movement is multiplied by 4 in relation to the normal linear mode. This mode can be accessed 
no matter which mode has been chosen on the sequencer (circular or linear). 

5.3.1.3 Mouse control (circular) 

Click on the knob and turn in a circle around it to change the value of the controller. The 
rotation mode gives a higher level of precision in the manipulation of controls: the farther the 
mouse goes from the knob, the higher the precision of the setting. 

5.3.2 Joysticks 

The usage page of the Moog Modular V offers two 2 dimensional control joysticks. The outputs 
can be used as a source of modulation for all of the synthesizers modules. The utility of these 
joysticks is that they simultaneously give control of two parameters to the mouse, with great 
ease. The 2 joystick outputs are visible in the conception page: 
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The control joystick outputs are available in the conception page 

When the joysticks are connected, the names of the concerned modulation inputs appear in 
the digital displays above the joysticks. 

  

The names of the connected modulation inputs appear above the joysticks 

5.3.3 Selectors 

The Moog Modular V presents selectors of several types: 
 

• The “switch” type selectors: simply click on these selectors to change their state. 

 

 “Switch” type selectors 

• Rotating selectors: used like knobs (by click and drag with the mouse) 

 

Rotating selectors 

• The digital displays: They are notably used in the sequencer. We can manipulate by 
click and drag (like the knobs), or by a simple click: a left click increments the value, 
while a right click (Shift + click for Mac) decrements the value. 

 

Digital displays 

5.3.4 Keyboard 

The keyboard lets us listen to the synthesizer sounds without having to use an external master 
MIDI keyboard, and without programming a melody in the sequencer. Simply click on a key to 
hear the corresponding sound. The keyboard also has a modulation wheel and a pitch-bend 
wheel, which can be moved with the mouse. 
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5.3.5 MIDI Control 

All of the knobs, cursors, joysticks, and modulation inputs of the Moog Modular V can be 
directed with external MIDI controllers. Before anything, make sure that the MIDI device that 
you wish to use is connected to the computer, and that the sequencer or Moog Modular V 
application is correctly configured to receive MIDI events coming from the device. 
 
Each instance of the Moog Modular V receives MIDI events transmitted on a certain channel. 
This reception channel is defined in a global manner for the synthesizer, either in your 
sequencer, or the independent Moog Modular V application (see the corresponding chapters). 
On the reception channel, the Moog Modular V can receive up to 120 different MIDI controls 
and a nearly infinite number with the NRPN mode. If your midi controller is able to work with 
NRPN, the Moog Modular will immediately recognize it by ticking the NRPN box (see below). If 
you get trouble with the NRPN setup, please contact the technical support of the midi device. 
 
 It is possible to choose a reception control for each knob. For this, click hold down the Control 
button on the keyboard and click on the knob that you wish to control. A configuration window 
will appear, allowing you to choose a MIDI control number. You can also click on the “Learn” 
button and manipulate one of your physical MIDI controllers. In this case, the control number 
will automatically be detected and configured. To deactivate the MIDI control of a knob, just 
uncheck the “Active” checkbox in the MIDI control window. 

 

Knob MIDI configuration control window 
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5.4 USING CABLES 

The connection of different modules is the base work of creating a new patch. The Moog 
Modular V owes its creative possibilities in no small part to the innumerable connections 
possible between modules. On the original system, all of the connections were made with 
cables of two types: 
 

� Audio and modulation cables (which allow for example the connection of an oscillator 
sawtooth signal to a filter input). 

 
� The trigger cables (which allow for example the connection of the keyboard to auxiliary 

envelopes). The trigger cables transport trigger information for envelopes or the 
sequencer for example. 

 
In the Moog Modular V, for ergonomics and graphical readability, only part of the connections 
is displayed on the screen in cable form. The other connections are made either by menus, or 
with digital displays on which we can click. 
 
The different types of connections we can use on the Moog Modular V are as follows: 
Audio connections / modulation connections: these connections are made with cables that are 
visible on the screen. 
 
Trigger connections: these connections are only done through menus.  
Synchronization connections: these connections are only done through menus. 
Key follow or sequencer connections: these connections are available and can be modified 
through visible digital displays on the filters and drivers modules. 

5.4.1 Audio and modulation connections 

The audio connections allow, for example, the routing of a sound to the VCA/mixers or to the 
inputs of different filters. The modulation connections allow, for example, routing of an LFO 
output or an envelope generator to an oscillator PWM or VCA modulation input. These audio 
and modulation signals are totally compatible, the only difference being that the audio signals 
are “audible” if you connect them directly to an output VCA, while the modulation signals are 
generally not audible (as the frequency is too low for the human ear). Modulation signals are 
thus generally used to program “slow” variations on certain synthesis parameters, like the cut-
off frequency of a filter for example. 
 
The audio output and input connectors, and the modulation output connectors are identical in 
the graphical interface: 

 

Audio input or output connectors, or modulation output connectors 

The modulation input connectors are graphically distinguished from the other connectors as 
they include an extra function: a modulation level setting, described later in this paragraph: 

 

Modulation input connectors 

To connect a modules output to the input of another module, click on the output and drag it to 
the target input while holding down the mouse button. When you are above the input, the 
connector lights. In this case, you just need to release the mouse button to link a cable 
between the selected output and input. 
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Creating a new cable and finding an appropriate input, by click and drag 

Another means is to right click (for Macintosh: click while holding shift on the keyboard) on the 
input or output of a module. In this case, a menu appears with a list of possible connection 
points for this output/input. It can happen that the input/output is already connected to certain 
modules, and in this case, the already selected connection points appear in the menu. Simply 
select one of the connection points in the “Connect to” menu to create a connection. It is also 
possible to delete all of the connections by choosing the “Remove connections” option or delete 
one of the connections by clicking on it in the menu. 

 

Input/output connection menu appears after a right click (or Shift + click) 

 The module inputs can only be connected to one output connector. On the other hand, each output connector can 

be connected to any number of input connectors, which allows, for example, the use of the same modulation signal to 

modify several synthesis settings. 

5.4.2 Modifying a connection 

To disconnect the end of a cable at input connector level, and reconnect it to another input, 
click on the end of the cable concerned and hold down the mouse button. You can now drag 
the end of the cable to another input with the mouse and release the button. 
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To delete a connection, you can use the menu available with a right click (or Shift + click). 
Another method is to click on the cable to select it, upon which the cable will appear in a 
lighter color to show that it is selected, and press the “DEL” button on the keyboard to delete 
the connection. 
 

 You will have a lot of trouble clicking on a cable if the “Move away cables” option is active. In this mode, the cables 

will automatically flee the mouse pointer. To avoid this, deactivate this option before trying to select a cable (see 

1.4.4.3) 

5.4.3 Modulation level setting 

As explained above, the modulation input connectors have an interesting feature: they allow 
the setting of a modulation level (from –100% to +100%) directly at connector level, and so 
without passing by a VCA which is normally needed to set the amplitude of the modulation 
signal. When the modulation input connector is connected, click on one of the edges of the nut 
and drag the mouse up or down to change the quantity of modulation: 

 

Setting the modulation quantity 

By using a right click (or Shift + click) instead of the left click, you will obtain a higher 
precision. 
 
Attention: If you click on the center of a connector, you will select the cable end to change the connection. To access 

the modulation setting, make sure you click on the connector device (the nut). In the same manner, if you right click 

(or Shift + click) on the center of the connector, you will open the connection menu instead of accessing the 

modulation quantity setting. 

5.4.4 Cable display options 

5.4.4.1 Cable display filter 

The Moog Modular V displays the cables in several colors depending on their type. The cable 
type is determined in relation to the input to which it is connected. Here is the list or colors 
and the corresponding cable type: 
 

• Red cable:  audio cable coming from an oscillator. 
• Yellow cable:  audio cable coming from a filter. 
• Green cable:  modulation cable coming from an LFO or auxiliary envelope. 
• Blue cable:  cable coming from a VCA / Mixer. 
• White cable:  other cables. 

 
The cable display filter allows the display of a section of existing cables in a given patch, 
depending on their type. The cable display filter is controlled by the buttons on the Moog 
Modular V toolbar: 

 

The cable display filter control buttons 

When a button is selected (pressed), the cables of the corresponding color are displayed. If the 
“ALL” option is selected, all of the cables are visible despite the state of the color filters. 
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5.4.4.2 Cable tension 

It is possible to set the Moog Modular V cable “tension” by using the knob in the toolbar of the 
synthesizer. Modifying the cable tension can help you to discover a region on the synthesizer 
that had previously been hidden by cables, without using the cable display filter. 

 

Setting cable tension 

5.4.4.3 Spreading the cables 

Visualizing the different cables existing between modules is very useful for the creation of a 
patch on the Moog Modular V. At the same time, cables can sometimes hide access to useful 
settings on different modules. So that you are not bothered by this, it can be useful to activate 
the “Move away cables” mode. In this mode, the cables will automatically move when the 
mouse comes across them, leaving a clear path for the modification or visualization of a knob. 
Don’t forget to deactivate this mode when you want to select a cable with the mouse to delete 
it . 

5.4.5 Trigger connections 

The trigger signals transport trigger information to the envelopes of the sequencer etc. 
Connecting the keyboard trigger output to an envelope, for example, allows the triggering of 
the envelope signal each time a key is pressed on the keyboard. 
 
The only trigger connections visible on the screen are trigger inputs. The output connectors are 
not displayed, their presence is implicit. When we click on a trigger input, the following menu 
appears: 

 

Trigger type input connection menu 

This menu tells us to which module a trigger input is connected, and allows us to create a new 
connection or delete an existing one. When a trigger input is connected, its graphical aspect 
changes, and this tells us if a module is connected without checking the menu: 

 

Trigger input disconnected – Trigger input connected 

5.4.6 Synchronization connections 

Synchronization connections are used to activate the synchronization of one of the nine 
oscillators available to another oscillator: 

 

Synchronization input 
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The same as for the trigger connectors, here, only the input connectors are visible, the 
existence of outputs is implicit, and the connections can only be made through the menus: 

 

Synchronization input connection 

5.4.7 Key follow or sequencer connections 

The Moog Modular V oscillators generate periodic signals in which the frequency varies in 
function with the note played on the keyboard. It is this difference in frequency, which allows 
us to recognize two different notes. To determine the ideal frequency related to a note played 
on the keyboard, the oscillator refers to a key follow. The function of the key follow is to 
convert a key on the keyboard to a Hertz frequency value that can be used by the oscillator. 
The Moog Modular V has four different key follows. The default setting for each key follow is 
that of the Western tempered (scale of twelve equal semi-tones). It is possible to set the key 
follows differently to create other types of scales (scale of quarter tones, tones, etc.). The key 
follows can be edited in the keyboard page of the synthesizer. At the level of each driver 
module and each filter, a digital display allows the selection of one of the four available key 
follows, by a simple click, as well as one of the 4 sequencer follows: 

 

Key follow digital display on a driver module or filter module 

The sequencer follow allows the easy creation of melodies with the sequencer, staying in the 
tempered intervals (semi-tones), which is more practical than using a sequencer output as a 
continuous oscillator pitch modulation, often difficult to tune. 
 
The following table explains the signification of the different values displayed: 
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Key follow 

 

Driver Oscillator Filter 
K1 Key follow No 1 K1 Key follow No 1 
K2 Key follow No 2 K2 Key follow No 2 
K3 Key follow No 3 K3 Key follow No 3 
K4 Key follow No 4 K4 Key follow No 4 
No No key follow 

LFO 
 
 
 

No key follow 
Or trigger from the keyboard; 

The oscillator works 
permanently on a polyphonic 

track (LFO mode) 

No 
 
 
 
 

No key follow 
 
 

 
 

 
Sequencer follow 

 

Driver Oscillator Filter 

S1 
Follow of line 1 of the 

sequencer 
S1 Follow of line 1 of the sequencer 

S2 
Follow of line 2 of the 

sequencer 
S2 Follow of line 2 of the sequencer 

S3 
Follow of line 3 of the 

sequencer 
S3 Follow of line 3 of the sequencer 

S4 
Follow of line 4 of the 

sequencer 
S4 Follow of line 4 of the sequencer 

No No sequencer follow No No sequencer follow 
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6 THE MODULES 

The Moog Modular V can be broken down into 4 parts, from top to bottom, a section containing 
sequencer and effects, a section dedicated to the sound programming, a small extension 
where the external cables are regrouped (velocity, after-touch, external signals...) and finally a 
section containing the keyboard and different play settings. 

6.1 PROGRAMMING SECTION 

6.1.1 Description 

The programming section gathers all of the modules, which need to be connected by cables. It 
is on this screen that the different connections (Patch) needed for the programming of the 
sound will be made. 
 
It is sometimes necessary to connect a module in the programming section to a module in the 
sequencer section. To simplify connections between the 2 screens, the inputs and outputs of 
the sequencer section are grouped on a small extension under the sound programming 
section. 
 

• The sound programming section contains: 
• Nine oscillators, grouped in threes, which can also be used as modulation source. 
• Two low frequency oscillators dedicated to modulations. 
• Three filters. 
• Six envelopes dedicated to modulations. 
• Two envelopes dedicated to output amplifiers. 
• A dual trigger delay. 
• A noise generator and the associated filters. 
• 1 ring modulator 
• 4 envelope followers 
• 2 sample and holds 
• 1 frequency translators 
• 1 formant filter 
• A set of amplifiers, which can be grouped to form mixers. 

 
The number of spaces at the upper part of the section being inferior to the number of modules, 
the choice is made through a menu. It is thus possible to organize them at your convenience. 
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6.1.2 Oscillators 

 
The oscillators, nine in total are regrouped in threes. Each group has a 921a type controller 
and three 921b type slave oscillators. 

 

 

A group of oscillators 

The controller is for the management of the impulse frequency and width of the 3 slave 
oscillators. It can be used either statically with the knobs or thanks to the modulation inputs, 
which can be connected to the output of any module (envelope, oscillator, modulation dial…).  
The slave oscillators can equally be tuned and modulated separately with a knob and a range 
selector. These oscillators provide four waveforms that can be used simultaneously. 
 
This method of organizing the oscillators, typical of Moog modular synthesizers, helps to 
rapidly obtain a very rich tone. The tree oscillators tuned separately and waveforms mixed give 
very dense tones. This tone can then easily be modulated with the controller. Adding a vibrato 
effect on this sonority is immediate using a modulation input of the controller. This would not 
be the case if each of the modulation inputs of the slave oscillators had to be set.  

6.1.2.1 Controller Type 921a: 

 

Oscillator 921a 

Frequency 

State 

Impulse 
width 

PWM Inputs FM Inputs 

Sequencer choice 
Keyboard 

Controller Oscillators 
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Frequency  : General tuning of the 3 slave oscillators 
State : General tuning mode choice (by 1/2 tone, by octave) 
Impulse width : Signal impulse width “Sawtooth”, “Square”,  “Triangle” 
FM Inputs  : Frequency modulation input connection jacks 
WPM Inputs : Pulse width modulation connection jacks 
Keyboard follow  : Keyboard follows choice tuning the master oscillator  

(off, no, follow 1,2,3 or 4). 
Sequencer Choice : Choice of the sequencer output tuning the master oscillator  

(no sequencer, sequencer 1,2,3 or 4). 
 
The general tuning of the 3 slave oscillators is done with the “Frequency” knob. Depending on 
the position of the “State” interrupter, the range of the knob is +/- an octave by semitone or 
+/- six octaves par fifth and quarter. 
 
The impulse width affected to the “sawtooth”, “triangle” and “square” signals of the 3 slave 
oscillators is modified with the “Width” knob. 
 
Three frequency modulation inputs and 2 impulse width modulation inputs allow the control of 
these parameters thanks to the outputs of the other modules. 
When one of these inputs is connected, a click on the Jack will modify the amplitude of the 
modulation. The Jack knob functions like a rotating dial where the position for inactivity (no 
modulation) is at the center. The modulation can thus be positive (button turned to the right) 
or negative (button turned to the left). 
 
Attention. The first two frequency modulation inputs work in an exponential mode, while the 
third, “Lin” works in a linear mode. 
 
Connected directly to a generator (envelope, oscillator, sequencer…), the maximum amplitude 
of the modulation is of +/- 4 octaves. When it is necessary to have a stronger modulation, an 
amplifier module must amplify the signal of the generator. 
 
A certain number of internal connections simplify the use of the keyboard follow, sequencer, 
portamento and pitch bend.  
To avoid having to manage the tuning of the keyboard follow with the amplitude of the 
modulation input, with a visualiser we can choose which keyboard follow (from 1 to 4) is to be 
used. This keyboard follow is directly configured to tune the oscillator in function to the note 
played.  
The functioning is the same for the sequencer outputs (1 to 4) controlling the tuning of this 
group of oscillators. In the “no” follow position, the oscillator is set to the note C3, irrespective 
of the keyboard notes. In the same manner, when set to the “no” sequencer position, this 
group of oscillators is disconnected from the sequencer output. 
A keyboard follow can of course be connected to modulation input. In that way, the pitch of 
each notes can be adjust very fine. We can then simulate the non-linearity of analog keyboard. 
 
The, “LFO” position of the display indicates that the oscillator group is no longer dependant of 
the keyboard. That is to say, it permanently functions on a monophonic voice. This function is 
especially useful when we want to use this oscillator group as source of low frequency 
modulation. 
 
Furthermore, each of the keyboard follows can activate the response of oscillators and filters to 
portamento and pitch bend. 
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6.1.2.2 Slave oscillator 921b: 

 

Oscillator 921b 

Frequency : Sets the frequency of the oscillator. By left click, setting by semi-tone, by 
right click fine setting. 

Range : Setting of the oscillator range. (low, 32, 16, 8, 4, 2) 
Synchronization : Synchronization interrupter Soft/Hard 
Synchro input : Menu to select the synchronization oscillator 
FM Inputs : Frequency modulation input connection jacks 
Outputs : Connection jacks for the four oscillator outputs  
 
The 921b type slave oscillators possess four outputs that can be used simultaneously: 
Sawtooth, sinusoid, triangle, square. 
 
There is also an output generating a trigger signal synchronous with the square signal and with 
an identical width, which lets us trigger envelopes and sequencer in a cyclic manner. This 
output is visible only visible at trigger input menu level. 

 

Sawtooth 

 

Square 

Frequency 

Range 

Synchronization 

Synchro input 

FM Inputs 

Audio outputs of 
the 4 wave forms  
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Triangle 

 

Sinusoid 

These oscillators are independently tuned with the “frequency” knob. This button possesses a 
coarse +/- an octave per semi-tone setting with a left click and a fine tune setting +/- a semi-
tone with a right click. 
 
The “range” selector allows the setting of oscillator range on 6 positions: Low, 32, 16, 8, 4 and 
2. With the Low position the oscillator can be used at a very low frequency (on a cycle of more 
than 6 minutes). The other positions set the oscillator to octaves 1,2,3,4 and 5. That is to say 
the note C3 is played respectively on C1, C2, C3, C4 and C5. 
 

 at the Low position the oscillators perform modulations using lower calculation power than the other positions. 

 
Two modulation inputs allow the separate setting of each of the oscillators in the group. They 
are very useful for modifying the tuning between oscillators thanks to a low frequency 
oscillator, a keyboard follow or other modulation source.  
Like the controller modulation inputs, they can be connected to the output of another module. 
Connected to an oscillator functioning in the same audible spectrum, they can obtain sonorities 
with FM characteristics. 
 
A synchronization input and the associated interrupter allow the synchronization of the slave 
oscillator on one of the other oscillators. In this case, the synchronizing oscillator will be heard 
while the synchronized oscillator will improve the tone. 
In the low position, the synchronization is said to be “hard”, which is to say that the 
synchronized oscillator will restart a cycle for every cycle on the synchronizing oscillator.  
In the high position, the synchronization is said to be “soft”, and in this case, the synchronized 
oscillator will only restart its cycle if it is coming to the end of the cycle when the synchronizing 
oscillator begins its cycle. 
 

 a connected oscillator is active and consumes calculation power. It is therefore necessary to verify that the 

connected oscillators are in use. Similarly, a group of oscillators disconnected from the keyboard by the “keyb” 

interrupter is permanently active. 

 

6.1.3 Filters 

 



ARTURIA – MOOG MODULAR V 2.5 – USER’S MANUAL 65 

The Moog Modular V possesses 3 filter modules. It is possible to choose one of four types of 
filter for each of the modules: a low-pass 24 dB/octave (type 904A), a high-pass 24dB/octave 
(type 904B), a band cut and band pass 24 dB/octave (type 904C) and finally a multi-mode 12 
dB/octave filter. Clicking on the name of the module and selecting the filter from the menu 
proposed does the type change. 
 
All of these filters possess internal connections to simplify the use of keyboard follows, 
portamento, pitch bend and sequencer.  
 
To avoid having to manage the tuning of the keyboard follow with the amplitude of the 
modulation input, with a display we can choose if a keyboard follow is to be used and which 
one. This keyboard follow is done to get a correct pitch from the keyboard. Depending on the 
configuration of the chosen keyboard follow, the portamento and the pitch bend will be applied 
or not to this filter. 
The functioning is the same for the sequencer outputs (1 to 4) controlling the tuning of the 
cut-off frequency of this filter. In the “no” follow position, the filter is independent of the notes 
played on the keyboard. In the same manner, set to the “no” sequencer position, the filter is 
disconnected from the sequencer output. 
It is still possible to connect a keyboard follow or a sequencer output to a modulation input 
obtaining a tuning as fine as necessary. 

6.1.3.1 Low pass 24dB Filter (904A) 

 

 

Low pass 24dB Filter 

Frequency 

Resonance 

Audio Output 

Audio Input 

Modulation inputs 

Sequencer choice 
Keyboard 
follow 
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Frequency  : Sets the filter cut-off frequency 
Resonance : Sets the filter resonance 
Audio Output : Filter output connection jack 
Audio Input   : Filter input connection jack 
Modulation inputs : Frequency modulation input connection jacks 
Keyboard follow  : Keyboard follow choice tuning the filter (no follow, follow 1,2,3 or 4). 
Sequencer choice  : Choice of the sequencer output tuning the filter  

(no sequencer, sequencer 1,2,3 or 4). 
 
The low-pass 24dB filter is typical of Moog synthesizers. It has a setting for the cut—off 
frequency and a setting for the resonance. Only connecting the output of any module to one of 
the 3 modulation inputs can dynamically modulate the cut-off frequency.  
 
Like all of the modulation inputs, once connected, turning the dial of the jack with a right click 
sets its amplitude. Receiving a modulation directly from the output of a generator (envelope, 
oscillator, and sequencer), the maximum modulation amplitude is of +/- 9 octaves. When it is 
necessary to have a stronger modulation, an amplifier module must amplify the signal of the 
generator. 
 
The following image represents the spectrum of a low-pass resonant filter with a cut-off 
resonance of 500 Hz. 

 

 

Low Pass 24 dB/Octave Filter 

6.1.3.2 High-pass 24dB Filter (904B) 

 

 

High-pass filter 24dB 

 

Frequency 

Audio Output Audio 
Input 

Modulation 
inputs 
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Frequency : Sets the filter cut-off frequency 
Audio Output : Filter output connection jack 
Audio Input   : Filter input connection jack 
Modulation inputs : Frequency modulation input connection jacks 
Keyboard Follow  : Keyboard follow choice tuning the filter (no follow, follow 1,2,3 or 4). 
Sequencer Choice  : Choice of the sequencer output tuning the filter 

(no sequencer, sequencer 1,2,3 or 4). 
 
Unlike the low-pass 904A filter, the high-pass 24dB filter does not possess resonance. The cut-
off frequency can be set with the rotating “frequency” dial or by the 3 modulation inputs which 
function in the same manner as the inputs of the low-pass. 
 
The following image represents the spectrum of a high-pass filter with a cut-off frequency of 
500 Hz. 

 

High Pass 24 dB/Octave 

6.1.3.3 Band-pass 24 dB (904C) 

 

 

Band Pass Filter 

Frequency : Sets the filter cut-off frequency 
Resonance  : Sets the bandwidth of the filter 
Type : Choice of filter type (band reject or band pass) 
Audio Output : Filter output connection jack 
Audio Input  : Filter input connection jack 
FM Inputs : Frequency modulation input jacks 
Mod. Width input : Bandwidth modulation input connection jack 
Keyboard follow  : Keyboard follows choice tuning the filter (no follow, follow 1,2,3 or 4). 
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Sequencer Choice  : Choice of the sequencer output tuning the filter  
(no sequencer, sequencer 1,2,3 or 4). 

 
The 24dB band pass filter resembles the Moog 904C filter, but the difference from it is that 
while the Moog 904C is a pairing of the 2 associated low-pass and high-pass filters, this one is 
independent of the 2 other filters. The central frequency can be set with the rotating 
“Frequency” button, the bandwidth, of 1/3 octave to 3 octaves with the “Resonance” knob. The 
first modulation input allows the dynamic modification of the bandwidth, the 2 others, the 
central frequency. 
 
A “type” selector provides a choice of filtering, band pass or band reject. 
 
The following images represent the spectrum of the band pass and band reject filters where 
the central frequency is 500 Hz. 

 

 

Band Pass 24 dB/Octave 

 

Band reject 24 dB/Octave 
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6.1.3.4 Multi-mode 12dB Filter 

 

 

Multimode 12 dB Filter 

Type     : Choice of filter type 
Frequency  : Sets the filter cut-off frequency 
Resonance : Sets the resonance of the filter 
Gain : Sets the gain for bell, shelf High and Low. 
Audio Output : Filter output connection jack 
Audio Input   : Filter input connection jack 
FM Inputs : Frequency modulation input jacks 
ModRes Input : Resonance modulation input connection jack 
Keyboard follow  : Keyboard follow choice tuning the filter (no follow, follow 1,2,3 or 4). 
Sequencer Choice  : Choice of the sequencer output tuning the filter  

(no sequencer, sequencer 1,2,3 or 4). 
 
The multi-mode 12dB filter, has different types of filtering that the original Moog modular 
synthesizers could not offer. The selector holds six types if filtering: Low pass, Band pass, 
Notch, High pass, low shelf, high shelf, bell. 
 
The 3 knobs “Frequency”, “resonance”, and “gain” respectively set the cut-off frequency, the 
resonance, and the gain (used only for the shelf and bell) 
 
Three modulation inputs allow the dynamic modification of the cut-off frequency. 
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The following images represent the different spectrum of the different filters, the cut-off 
frequency is constant at 500 Hz. 
 

 

Low Pass 12 dB/Octave 

 

High Pass 12 dB/Octave 

 

Notch 12 dB/Octave 

 

Bell 12 dB/Octave 

 

Low shelf 12 dB/Octave 



ARTURIA – MOOG MODULAR V 2.5 – USER’S MANUAL 71 

 

High shelf 12 dB/Octave 

6.1.4 Modulation envelopes 

 

Envelope 

Attack  : Sets the attack time (Attack) 
Decay : Sets the decay time 
Release : Sets the release time 
Sustain : Sets the sustain level 
Input Trigg : Trigger signal input connection 
Output : Envelope output signal 
 
Six in total, the modulation envelopes make the sonority evolve in function with time. An 
envelope possesses four sequentially following temporal periods: attack, decay, sustain and 
release. When the input trigger goes from an inactive to an active state, the envelope launches 
its sequences “attack” followed by “decay” and remains in the  “sustain” state as long as the 
input trigger remains active. When it goes to an inactive state, the envelope begins the 
“release” sequence. If the input trigger becomes inactive before the first 2 sequences have 
finished, the envelope goes directly to the  “release” phase. 
 
The input trigger can be connected to the output trigger coming from the keyboard, the trigger 
delay module, the oscillators trigger output, or from the sequencer. 
 
The time of the different periods are controlled by the “Attack”, “Decay” and “Release” knobs. 
The “Sustain” knob is to set the level of the envelope output during the sustain period.  

Attack (A) 

Decay (D) 

Release (R) 

Sustain (S) 

Input Trigg Output 
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Representation of the envelope 

6.1.5 Output amplifiers (VCA) 

 

Output envelope 

Attack  : Sets the attack time 
Decay : Sets the decay time 
Release : Sets the release time (release) 
Sustain : Sets the sustain level 
Slope Time : Sets the intermediate decay time 
Slope Level : Sets the intermediate decay level 
Input Trigg : Input trigger signal connection jack 
Envelope out : Envelope out connection jack 
Audio Input : VCA input connection jack 
Panoramic : Sets the position in stereo space 
Soft Clip : Use of gentle saturation 
AM Input : Audio modulation Input jack 
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There are 2 output amplifiers, each possessing its own envelope. These amplifiers are 
internally linked to a panoramic manager, which allows, through the “panoramic” knob, to 
position the output in stereo space. 
 
These amplifiers are the last step in the generation of a sound. The associated envelope 
sculpts the temporal form of the signal at the end of the sequence after the application of all of 
the other modulations. Unlike the modulation envelopes, it has an extra period between the 
“attack” and “decay” sequences, called “slope”. The time and level can be set for this period 
and allows the envelope to move from the high point after attack to slope before moving to the 
decay: 
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Representation of the output VCA envelope 

 
The output amplifier internally connected to this envelope has volume “gain” and amplitude 
input modulation settings.  
 
The input trigger can be connected to the output trigger coming from the keyboard, the trigger 
delay module, the oscillators or LFO trigger output, or from the sequencer. 
 
Each of the two amplifiers possesses a trigger output, which is activated when the signal level 
is cancelled. This output can be very useful for stopping the sequencer for example. 
 
A jack allows the connection of the output of the associated envelope to other modulation 
inputs. 
A button applies the simulation of the current regulation present in the original Moog amplifiers 
(soft clipping).  
 

 soft saturation is heavy on CPU calculation 
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6.1.6 Low frequency oscillators (LFO) 

 

Low frequency oscillator 

Frequency : Sets the oscillation frequency  
Delay : Delay time setting after a keyboard trigger  
Mode : Choice of frequency setting: low, mid, synchronized on the MIDI tempo  
Fade in : Sets the time constant for the increase of modulation 
Width : Sets the impulse width  
PWM Input : Input connection for the impulse width modulation 
FM Input : Frequency modulation input connection 
Outputs : Connection jacks for the different outputs 
 
The use of a low frequency generator as a modulation source is typical. It allows the gentle 
evolution of the tone of a sound or to simulate vibrato and tremolo. 
Even though the oscillators can be used at very low frequencies, there are 2 modules 
specifically for this purpose, which allow the oscillators to be kept for use in the audible 
domain. 
 
These oscillators possess five outputs that can be used simultaneously: sawtooth, sinusoid, 
triangle, square, random. 
 
The oscillation frequency can be statically set with the rotating “frequency” button dynamically 
with the associated modulation input. The impulse width can also be statically set with the 
“width” button and by its modulation input.  
 
The “mode” interrupter synchronizes the oscillation frequency with the tempo of the host 
sequencer. In this mode, the rotating button chooses a frequency depending on the 
application’s tempo (multiple or sub multiple). 
 
Two other buttons are affecting a delay and a fade in at the output of this generator. Initialized 
on a keyboard trigger, the generator output will only begin to oscillate when the internal 
counter reaches a time value set with the “delay” knob. This oscillation wills gently increase 
following the time constant set with the rotating “fade in”. 
 
 There is also an output generating a trigger signal synchronous with the square signal  and 
with an identical width, which lets us trigger envelopes and sequencer in a cyclic manner. This 
output is visible only visible at trigger input menu level. 
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6.1.7 Controlled amplifiers / Mixers 

 

Controlled amplifier (VCA) 

Audio Input : Amplifier input connection jack 
Audio Output : Amplifier output connection jack 
AM Input  : Amplitude modulation input connection jack 
Volume  : Input gain setting 
Soft Clip  : use of soft clipping 
Inverse  : request inversion of the input signal 
Link  : next amplifier mixing  
 
There are 16 independent amplifiers. Each has its own volume setting with the rotating “level” 
button and its amplitude modulation input. 
 
These amplifiers can be regrouped to form mixers. To group 2 amplifiers, just click on the 
“Link” button separating them.  
When 2 amplifiers form a group, the output signal of the first corresponds to the sum of their 
collective outputs, whereas the output of the second remains identical to the signal before 
grouping.  
To restore their independence, just click on the “Link” button. 
It is possible to add as many amplifiers as necessary. In this case it is still the output of the 
first amplifier, which will have the signal corresponding to the sum of all of the amplifiers of 
the group, the others retaining their independence.  
 
Thanks to this method, with 16 amplifiers to begin with, it is possible to create a large range of 
mixing while keeping a few amplifiers available for modulation. 
We can, for example, form a group of the first six amplifiers to mix the first six oscillators, 
then a group with the next 3 to mix the 3 last oscillators, and finally a group with the next 2 to 
mix the outputs of 2 filters which will respectively treat the output of the first amplifier and the 
output of the seventh. There are 5 remaining amplifiers for modulation or other mixes. 
 
Each amplifier possesses a current limiting function allowing a soft clipping. This function is 
activated with the “clip” button. The “inv” button lets you invert the signal, as input to the 
corresponding amplifier.. 
 
The four right VCA are modulated with a linear function, on the contrary, the other are 
modulated with a exponential function. 
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6.1.8 Trigger delay 

 

 

Trigger delay 

Time 1  : Sets the time for the first delay 
Trigg 1 Input : Choice of trigger input for the first delay 
Mode : Choice of mode (independent, parallel, series) 
Time 2  : Sets the time for the second delay 
Trigg 2 Input : Choice of trigger input for the second delay 
 
A trigger delay module manages the signals used for triggering envelopes and sequencer. 
There are 2 delays, which can function independently, in series or parallel following the setting 
on the “mode” selector. 
 
Set to the “off” position, the 2 delays are independent. When their trigger input moves to an 
active state, their internal counter is initialized. The output will move to an active state when 
their internal counter reaches the value specified by the rotating “time” button. When the 
trigger input returns to an inactive state, the output immediately goes not an inactive state. 
 
Set to the “parallel” position, the 2 internal counters start at the same time when the trigger 
input of the first delay goes to an active state. Each manages its output in function with its 
time setting. 
 
In the series position, the second counter only begins when the output of the first delay moves 
to an active state. 

Time
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Independent mode 

 

Parallel mode 

 

Serial mode 
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6.1.9 Noise generator 

 

Noise generator 

Low Pass Frequency : Sets the low-pass filter cut-off frequency 
Low Pass input  : Low Pass filter input connection jack 
Low Pass Output  : Low Pass filter output connection jack 
Low Pass Frequency : Sets the Low Pass filter cut-off frequency 
High Pass Output  : High Pass filter output connection jack 
High Pass Input : High Pass filter input connection jack 
White Noise : White noise output connection jack 
Pink Noise  : Pink noise output connection jack 
 
The noise generator allows the simultaneous management of a white and pink noise. It also 
possesses a low-pass and a high-pass of the first order (6 dB/octave) in which the cut-off 
frequency can be statically set with the “frequency” knobs. 

 

 

White noise spectrum 

 

Pink noise spectrum 
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Whether it is for white or pink noise, the two output jacks correspond to two independent noise 
generators. 

6.1.10  Sample and hold 

 

Sample and hold 

Clock Rate   : Sets the internal clock frequency 
Trigg input : Menu selecting the choice of external input used to trigger the sampling 
Trigg selection : Choice source of external trigger for sampling 
Glide   : Sets output glide 
Output   : Output connection jack  
Input             : Input connection jack 
 
This module lets you sample the signal connected as input. The values are taken for every 
trigger where the source can be external (trigger source connected to the Trigg input) or 
internal, clock where the frequency is set with the “Clock Rate” dial. The choice is made with 
the “Trig selection” interrupter. 
 
The values sampled are presented as output, with more or less glide, set with the “Glide” dial. 
 
It is this module, when sampling noise, which is used to product random modulations. 
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6.1.11 Envelope follower 

 

Envelope follower 

Time choice  : Selection of follow mode 
Time   : Sets the constant time of the level mesurment 
Threshold  : Sets the threshold of comparator 
Follower out  : Envelope follow output connection jack 
Follower in  : Envelope follow input connection jack 
Comparator in  : Comparator input connection jack 
 
This module possesses two functions. The first generates an envelope from the audio signal 
connected to “Follower in”. The “Time” setting determines the detail for the envelope follower. 
The lower the value, the more the input signal variations will be respected. This setting relies 
on the “Time Choice” which can be “short” or “long”. In the first case, the analysis of the input 
signal will be very precise, generating a signal with fast variation. The calculation power 
required is thus heavier than the second position, where the output signal will have slow 
variation. 
 
This module also allows you to generate a trigger signal. The triggering is calculated in relation 
to a certain threshold set with the “Threshold” dial and the signal connected to the 
“Comparator in”. If no signal is connected to this input, an internal connection will link the 
follow output to the comparator. 
 
This module generates two types of trigger, a positive trigger, and a negative. When the 
comparator input signal exceeds the threshold, the positive trigger is activated, while the 
negative trigger is cancelled. When the input signal goes below the threshold, the opposite 
happens. A lighting indicator allows the observation of the positive trigger signal. 
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6.1.12  Ring modulator 

 

Ring modulator 

Frequency  : Sets the frequency of the multiplicative sinusoid 
Depth  : Sets the amplitude for the multiplication of signals 
HiQ Selection : High quality selection 
Freq. Mod.  Input : Frequency modulation connection jack  
Depth Mod. Input : Depth modulation connection jack  
Mul Signal Input : Multiplicative signal connection jack  
Signal Input : Input jack for signal to be treated  
Signal output : Output jack for treated signal 
 
The ring modulator multiplies two signals to create non-harmonics frequency. It is then easy to 
produce metallic sounds. 
When “Mul Signal Input” is not connected, the input signal is multiplied by an internally 
generated sinusoid signal for which the frequency can be set with the “Frequency” button. The 
modulation amplitude and subsequently the effect amplitude obtained can be set with the 
“Depth” button. Once connected, “Mul Signal Input” becomes the source of the multiplicative 
signal.  
 
The depth and the frequency of the internal sinusoid can be modulated with the corresponding 
modulation inputs. 
 
The “HiQ” interrupter, at the cost of an increase in calculation load, increases the quality of the 
sound.  
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6.1.13  Formant Filter 

 

 

Formant filter 

Frequency   : Sets the frequency 
Resonance  : Sets the resonance 
Gain   : Sets the gain 
FM Input  : Frequency modulation connection jack 
RM Input  : Resonance modulation connection jack 
GM Input  : Gain modulation connection jack 
Vowel   : setting of o pre-selected vowel 
VM Input  : Connection jack for the modulation of the vowel pre-selections 
 
This module regroups four bell filters connected in a series. Each filter can be set and 
modulated, independently of the others, in frequency, gain and resonance (or bandwidth).  
It is possible to preset these four filters to reproduce the formation of a particular vowel with 
the “vowel” selection window. This preselection can also be modulated with the associated 
modulation input. 
The preselection is done before the filter settings. It is thus possible, during a modulation, to 
make the vowel evolve, and to gently change the settings. 
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6.1.14 Bode Frequency Shifter 

 

Bode frequency shifter 

 
Scale : Sets the scale frequency 
Amount of Shift : Sets the frequency transition 
Mix : Mix between the positive and negative translations 
Mixed output : Mix of negative and positive translations output connection jack 
Positive output : Positive translation output jack 
Negative output : Negative translation output jack 
FM Input : Frequency modulation connection jack  
Audio Input   : Input signal connection jack  
 
This module is used for a linear translation of the frequencies contained in the input signal. 
Because of this linearity, the initial harmonic relations are totally modified.  
It is easy with this module, to produce metallic sounds. 
There are three available outputs: two for each of the translations possible (negative and 
positive), the other for a mix of the two, the mix is set with the  “Mix” button. 
 
The translation rate, which is to say the difference in frequencies, is set with the “frequency” 
button. Following the selected scale (“scale” selector), the button will give a different gap. The 
scale also influences the amplitude and type of modulation.  
 
In the exponential position, the translation goes from 2 Hz to 1024 Hz, the modulation being 
exponential. In the other positions (5,50,500,5k), the translation will be of a maximum of 5 
Hz, 50 Hz, 500 Hz or 5000 Hz, in positive or negative. 

6.2 SECOND SECTION 

6.2.1 Description 

 
The second section of the Moog Modular V regroups all of the effect modules and the 
sequencer. The outputs and inputs of this page needing connections with the modules of the 
first section are moved to the latter, in a small extension. 
 
This section contains a module for equalization through a bank of resonant filters, a chorus 
module, a phaser, a stereo delay module, and a type 960 sequencer. 
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The 3 effect modules, filter bank, chorus and stereo delay are applied to the signal of the 
output amplifiers in function with the interrupters “vca1” and “vca2”. They are applied in the 
predefined order. 
 
The choice between the chorus and the phaser is done through a menu displayed by clicking 
on the name of the module. 
 

6.2.2 Resonant filter bank 

 

Filter bank 

Gain  : Sets the band level to positive or negative 
Resonance : Sets the bandwidth 
Connection VCA1-VCA2 : Connection of the filter bank to the VCA1 or VCA2 output 
Output Gain  : Sets the output gain 
Reset : Resets the filter bank 
 
This module allows the equalization of the signal coming from the 2 output amplifiers in 
function with the state of the interrupters “vca1” and “vca2”.  
This equalization is done with the help of the resonant filters and has 14 bands. Each has a 
level (amplification and alleviation) and bandwidth setting, excepting the first and last bands, 
which are respectively, the low-pass and high-pass filters.  
The cut-off frequencies of these filters are fixed at the following values: 80 Hz, 125 Hz, 175 
Hz, 250 Hz, 350 Hz, 500 Hz, 700 Hz, 1000 Hz, 1400 Hz, 2000 Hz, 2800 Hz, 4000 Hz, 5600 Hz 
and 6400 Hz. 
 
A button allows the resetting of the default values and a rotating button sets the output level 
after filtering. 
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6.2.3 Chorus 

 

Chorus 

Types    : Sets the 3 chorus Types 
Rate    : Sets the chorus rate 
Depth    : Sets the depth of the chorus action 
Time    : Sets the delay applied to the input signal 
Stereo Rate   : Sets the speed of the stereophonic evolution 
Stereo Width   : Sets the width of the stereophonic space 
Dry    : Sets the gain applied to the input signal 
Wet    : Sets the gain applied to the treated signal 
VCA1-VCA2   : Connection of the chorus to the output of VCA1 or VCA2 
 
A Chorus module allows the treatment of the signal coming from the 2 output amplifiers, 
eventually treated by the equalizer, in function with the state of the interrupters “vca1” and 
“vca2”. 
 
The chorus module allows a frequential blurring where the speed is set by the “speed” knob, 
the amplitude by the “depth” and the width with the “Delay”. This frequency blurring is 
different for the left and right tracks. This allows us to get a stereophonic signal from a 
monophonic signal. The difference between the 2 tracks can be set with the “stereo width” and 
the speed of the left right rotation with the “stereo rate” knob. 
 
A selector presents the choice of chorus type: simple, medium, complex. 
 
The input signal level and treated signal can be respectively set with the “gain direct” and 
“gain effect” knobs. 
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6.2.4  Phaser 

 

Phaser 

Amount : Sets the depth of the phaser action 
Rate : Sets the speed of the phaser 
Sweep : Sets the phaser resonance 
Stereo width  : Sets the width of the stereo space 
Dry : Sets the gain applied to the input signal 
Stages : Sets the phaser type (6 or 12 stages) 
Wet : Sets the gain applied to the treated signal 
VCA1-VCA2 : Connects the phaser to the VCA1 or VCA2 output 
 
The phaser module treats the signal coming from the 2 output amplifiers, eventually treated 
by an equalizer, in function with the state of the 2 “VCA1” and “VCA2” interrupters. 
 
The action consists of dephasing the input signal and combining it with the original signal. Thus 
we can have a filter that combs (with notches) the frequency spectrum to the rhythm of an 
oscillator which follows the frequency set with the “rate” button. The “depth” button sets the 
amplitude for the action of the filtering, while “Resonance” amplifies certain harmonica. The 
rotating “stereo width” button sets the amplitude of the stereophonic aspect of the phaser. 
When the “stereo width” is set to 0, the left and the right channel are in phase. When it is set 
to 0.5, the sound seems to rotate, and when it is set to 1, the sound seem to go from one side 
to another. 
There are two types of phaser, one has 6 levels, the other has 12, set with the “type” selector. 
A 6 stages phaser has 3 notches, and a 12 stages has 6. 
 
The rotating “dry” and “wet” buttons are respectively used to set the amplitude of the original 
signal and the treated signal. 
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6.2.5 Stereo Delay 

 

Stereo Delay module 

Midi sync : Synchronizes delay with the tempo of the host application 
Time left : Sets the time of the right track 
Time right : Sets the time of the left track 
Feedback left : Sets the feedback gain for the right track 
Feedback right : Sets the feedback gain for the left track 
Feedback to left : Sets the feedback gain of the right track towards the left track 
Feedback to right : Sets the feedback gain of the left track towards the right track 
Dry  : Sets the gain applied to the input signal 
Wet : Sets the gain applied to the treated signal 
VCA1-VCA2 : Connection of the delay to the output of VCA1 or VCA2 
 
A stereo delay module treats the signal coming from the 2 output amplifiers, eventually 
treated by the equalizer and chorus, in function with the state of the interrupters “vca1” and 
“vca2”. 
 
This module allows the repetition of the input signal independently on the left and right tracks, 
which explains the presence of 2 columns of controls.  
The repetition speed can be set with the “time” knob, while the level of the repetitions, and 
eventually the number of audible repetitions is set with the “feedback” knob. The third knob 
sends a part of the treated signal to the other track. 
 
The repetition speed can be synchronized with the tempo of the host application, and in this 
case, the “time” knob selects the multiples and sub-multiples of this tempo. 
 
The levels of the input and treated signals can be respectively set with the rotating “gain 
direct” and “gain effect” buttons.  
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6.2.6 Sequence generator 

 

Sequencer 

Also called sequencer, this module is similar to the original Moog 960 sequencer while 
simplifying the programming with internal connections. 
 
This module has 3 parts, low frequency oscillator, the 8-step sequence manager and the 
output controller. 

 

Sequencer clock 

Frequency  : Sets the sequencer clock speed 
On  : Starts the sequencer 
Off  : Stops the sequencer 
On Input Trigger  : Connection of a trigger signal to start the sequencer 
Off Input Trigger  : Connection of a trigger signal to stop the sequencer  
Length  : Length of the trigger signal generated by the sequencer 
Midi Synchronization : Synchronization of delay with host application tempo 
Next Trigger  : Connection of a trigger signal for the passage to the next step 
Fw - Fw/Bw  : select the sequencer mode (forward, or forward/backward) 
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The low frequency oscillator gives rhythm to the passage from one sequence to another. The 
speed can be statically set with the “frequency” knob and dynamically with the modulation 
input situated on the first section. The “synchronization” interrupter synchronizes this 
generator on the tempo of the host application. In this case, the “frequency” knob selects 
multiples and sub-multiples of this tempo.  
 
The passage from one step to the next can also be done by the means of a trigger signal (from 
the keyboard for example) connected to the “next trigger” input. 
 
The two “On” and “Off” button start and stop this generator. When it starts, it resets the 
sequence manager on the first step. 
 
The starting and stopping can be done dynamically with the associated trigger inputs. 
The “length” knob sets the trigger signal width coming from the sequencer. 
The “backward” interrupter allows a round-trip progression, instead of a progression indicated 
by the next step indicators 

 

Sequencer column 

Level Output1 : Sets the level of modulation or tuning for output1 
Level Output2 : Sets the level of modulation or tuning for output2 
Level Output3 : Sets the level of modulation or tuning for output3 
Link   : Link to the previous step (no trigger) 
Hold : Number of clock beats of hold on this step 
Repetition : Request for output trigger for each held clock beat  
Next Step : Selects the next step 
On : Forcing step 
Forcing trigger input : Forcing input or not 
 
The sequencer has 8 steps. Each step defines 3 output levels with the help of 3 rotating 
buttons. The manager moves from one step to another at each impulse of the sequencer clock 
or upon the reception of a signal on the trigger input “next trigger”. The led above each of the 
steps lights up when active. 
 
It is possible to force the sequencer to initialize itself on a particular step, either by clicking on 
the “Forcing” button of the desired step, or through a signal in the associated input trigger. 

Level Output1 

Level Output2 

Level Output3 

Link 

Repetition 

Hold 

Next Step 

On  Forcing trigger input 
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Every time the sequencer comes to a step, the corresponding trigger output is activated, 
allowing the start-up of certain envelopes. 
It is possible to remain on a particular step by modifying the “Hold” display. In this case, we 
need a certain number of clock impulses from the sequencer (or from the trigger input) equal 
to the number indicated to go to the next step. 
 
The rotating selector indicates the next step. It possesses 10 positions, the first 8 represent 
the next steps, the ninth is a random selection, and the last is the generator stop. 
When this last position is chosen on a step, the sequencer clock is stopped, the manager is 
reset on the first step and the outputs set to zero. 
 
At every change of step, a general trigger signal from the sequencer is activated. This output 
will be activated at every clock impulse if the “repetition” interrupter is active. In the same 
manner, there is no activity from this signal if the “link” interrupter is inactive.  
 
 

 

Sequencer outputs 

Smooth 1 : Sets smooth for output 1 
Smooth 2 : Sets smooth for output 2 
Smooth 3 : Sets smooth for output 3 
Smooth 4 : Sets smooth for output 4 
On Line1      : Forcing of the selection from output 4 to output 1  
Forcing Trigger Input 1  : Forcing trigger input of the selection from output 4 to output 1  
On Line2 : Forcing of the selection from output 4 to output 2  
Forcing Trigger Input2  : Forcing trigger input of the selection from output 4 to output 2 
On Line3 : Forcing of the selection from output 4 to output 3 
Forcing Trigger Input3 : Forcing trigger input of the selection from output 4 to output 3  
Mode Output4       : Choice of progression mode of output 4  
 
The control section of the sequencer outputs allows the management of four outputs in 
function with the current step. The first outputs take their values from the values specified by 
the rotating buttons of the current step, eventually with a smooth that can be set with the 
“smooth”.  
 
The fourth output, for which the smooth can also be set with a “smooth” knob, is managed in 
the following manner. It takes the value of one of the 3 outputs in function with the current 
step and the type of progression specified by the “Mode output 4” selector. 
 

Smooth1 

Smooth2 

Smooth3 

Smooth4 

On Line 1 

Forcing Trigger Input 1 

On Line 2 

Forcing Trigger Input 2 

On Line 3 

Forcing Trigger Input 3 

Mode Output 4 
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When placed in the “none” position, the fourth output takes the output value selected by the 
“Forcing Line” button and its corresponding trigger input. It is therefore possible to have 3 
different sequences, activated either manually by a click or dynamically by a trigger. 
 
When the “Mode Output 4” selector is placed on the “L123” position, the fourth output will 
automatically cross outputs 1,2 and 3 each time the current step arrives on the eighth step. In 
this manner, it is possible to have a 24-step sequence. Placed at the “L321” position, the lines 
will be done in the inverse order.  In the same manner, on the “L12” “L13” or “L23” positions, 
the fourth output will cover lines 1 and 2, or 1 and 3, or finally 2 and 3, thus obtaining 16 step 
sequences. 
 
When the “Mode Output 4” selector is placed on the “C123” position, the fourth output covers 
lines 123, but the change takes place at every sequencer clock impulse. We just need to wait 
for 3 impulses at every step, to alternatively have lines 1,2 and 3 of each of the steps. The 
functioning is the same on positions “C321”, “C12”, “C13” and “C23”. 
 
On the “Rand” position, the choice of fourth output is random. 

6.3 THIRD SECTION 

A small section has been added bellow the connection section. It regroups all of the external 
input-outputs on the sequencer, and the key follow outputs. You will also find an interrupter 
which activates A440. 
 
The output jacks “External audio” are used to treat the external signals and use the Moog 
Modular V as an effect.  
The “Out” jacks correspond to the two left and right output jacks on the Moog Modular V. It is 
thus possible to loop it to itself and obtain special effects. 

 

 

Internal connections 
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6.4 FOURTH SECTION 

The fourth section contains a virtual keyboard, control for the 4 key follows, 2 modulation 
surfaces, and a few shortcuts to the most frequently used settings (Envelope for the 2 output 
VCA and cut-off frequency settings for the 3 filters). You will also find general settings like 
choice of Monophonic/polyphonic, the “retrigg” mode or “legato”. 
 
It is also in this mode that we find the volume control and general tuning. 

6.4.1 Keyboard follow management 

 

Keyboard Follows 

Slope : Sets the slope of the keyboard follow 
Pivot : Selects the pivot note of the keyboard follow 
Threshold  : Selects the threshold note of the keyboard follow 
Low/High : Selects the low (high) note of the generator for the trigger of the keyboard 

follow 
High : Selects the high note of the generator for the trigger of the keyboard follow 

which can also be inverted 
Bend/Portamento : Request for affectation of a pitch bend (portamento) or glissando to the 

keyboard follow 
 
There are four independent keyboard follows. Each possessing a slope setting with the “Slope” 
knob, a pivot note chosen in the “pivot” display and a threshold note chosen with the 
“threshold” display begin from which the slope is null.  

 

Keyboard follow management 

Each of the keyboard follows can generate a trigger signal. Two displays allow the choice of a 
low and high note. When the keyboard detects a note between the 2 limits, the trigger signal 
is active as long as the note remains active. When the note is outside of the limits, the trigger 
signal remains inactive. If the notes selected for the upper and lower limits are such that the 

Slope 

Pivot 

Threshol

Low/High 

Bend/Portamento 
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lower note is higher than the upper, then the note detected by the keyboard must be outside 
of the limits to activate the trigger signal. 
 
The “Portamento” and “PitchBend” buttons of each of the keyboard follows allows the 
affectation of a portamento or pitch bend. The pitch bend can be inverted (the modulation is 
negative when the command is positive), which allows us, for example, to lower the filter cut-
off frequency insofar as the tuning of the oscillators is raised. 
It is also possible to replace the portamento (continuous glide of the frequency) with a 
glissando (frequency glide by semi-tone) 

6.4.2 General settings 

 

general settings 

Course Bend (filter) : filter coarse for the pitch bend wheel 
Course Bend (accord) : Oscillator tuning coarse for the pitch bend wheel. (by semitone 

from 0 to 4 octaves) 
MonoPoly : Selects synthesizer mode: ( Monophonic, Unison or polyphonic ) 
Legato : Selects legato mode  

(the portamento is active when the   notes are detached). 
Re Trigger :Selects the re trigger mode  

(the keyboard generates a trigger when the notes are linked) 
Nbr Release : select the number of release notes 
Poly : Gives the number of polyphonic tracks (16-32-64) 
 
The Moog Modular V responds to the pitch bend depending on the position of the “tune” 
selector. This selector sets the amplitude of this response to +/- four octaves per semi-tone. 
The knob close at hand noted “filter”, allows the setting of the excursion of the response to the 
tuning wheel for the filter cut-off frequency,  
 
The “MonoPoly” interrupter takes the synthesizer from monophonic to polyphonic mode. The 
Unison position allows us to play the indicated number of voices in parallel, while the playing 
mode remains monophonic. 
 
In the monophonic mode, 2 interrupters allow the control of the triggering of the envelopes. 
The first, “re trigger” allows the reactivation of the trigger signal in the case where the notes 
are linked. The second, “legato” allows the affectation of frequency smoothing (portamento) 
whether the notes are linked or not.  
 
The rotating “Volume” button sets the general volume of the Moog Modular V, while the 
rotating “tune” button allows us to set the tuning with an amplitude of 1 tone. 

Course Bend (filter) Course Bend (tune) 

Mono-Poly 

Legato Re Trigger 

Poly 
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7 THE BASICS OF SUBTRACTIVE SYNTHESIS 

Of all of the forms of sound synthesis, subtractive synthesis is still one of the oldest and most 
frequently used today. This method was developed from the 60’s on Moog analog synthesizers, 
and then later on ARP, Buchla, Oberheim, Sequential Circuits (Prophet series), Yamaha (CS 
series), Roland, Korg (MS and PS series) to name but a few. This synthesis technique is still 
used on most of the current digital synthesizers, added to sample reading or wave tables, 
which have progressively replaced analog oscillators since the 80’s. The modular Moog 
systems, and your Moog Modular V, represent the best illustration of the immense possibilities 
of subtractive synthesis. 
 
Modular synthesizers use a certain number of base modules, placed in sections where the size 
varies in relation to the importance of the systems. These modules, once connected, allow the 
creation of a multitude of sounds.  

7.1 THE THREE MAIN MODULES  

7.1.1 The oscillator or VCO 

The oscillator (Voltage Controlled Oscillator) can be considered as the starting module (with 
the noise module that we often class among the oscillators) for the creation of a sound on a 
modular system. It is here that the first sound signal is created and we can consider the 
oscillator like the strings of a violin which, when stroked or plucked, vibrates to create a sound. 
 
The main oscillator settings are: 
 
The pitch determined by the oscillation frequency.  
The oscillator frequency setting is done with two controllers: firstly the Range selector which 
mainly determines the fundamental frequency, often expressed in feet: 32,16,8,4,2 — the 
highest number (32) gives the deepest tone, and on the other hand, 2 gives the highest tone; 
Secondly, the frequency setting which will tune the oscillator more precisely. 
 
The waveform, which determines the harmonic richness of the audio signal. 4 waveforms are 
available on the Moog Modular V:  
 

• The sawtooth is the richest audio signal of the 4 available waveforms (it contains all of 
the harmonics at decreasing volume levels in high frequencies). Its “brassy” sound is 
ideal for brass sounds, striking bass sounds or rich accompaniments. 
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The square possesses a more “hollow” sound than the sawtooth (it only contains impair 
harmonics) but nevertheless, its sonic richness (notably in the low frequencies) could be used 
for sub basses emphasized in the mix (the square oscillator should be thus set an octave below 
the that of the saw tooth), wooden sounds (clarinet if the square signal is a little filtered), 
etc.… 
 
The PWM (Pulse Width Modulation) is a setting, which allows the modification of the square 
ware form cycle (or wave width). This can be done manually with the “PW” knob or through 
modulation (using an envelope or a LFO). This variation of impulse width is translated by a 
spectrum modification, not unlike a waveform change. 
 
Unlike classic analog synthesizers, the Moog Modular V allows you to change the impulse width through not only the 

square waveform, but also the sawtooth and triangle. 

This offers a large number of sonorities on top of the base signals. 
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The triangle could be considered like a much-filtered square signal (thus very soft). It is very 
poor in harmonics (impair equally) and will be very useful for creating sub basses, flute 
sounds, etc.… 

 
 

 
The sinusoid is the purest waveform of them all. It is composed of a single fundamental 
harmonic and produces a very “damper” sound (the tonality of a telephone is sinusoid). It will 
be used to reinforce the low frequencies of a bass sound or as a frequency modulator in order 
to create harmonics that do not exist in the original waveforms.  

 
 

 
A frequency modulation (FM) can be created between 2 oscillators by connecting the audio 
output from a first sinusoidal oscillator to the modulation input of a second oscillator. On the 
Moog Modular V, if you turn the modulation rate ring, you will obtain a sound richer in 
harmonics. If you introduce a square or sawtooth signal, the result can be quickly distorted… 
but interesting for inharmonic sonorities like bell sounds or special effects for example.   

 
 

The synchronization of an oscillator on another brings about complex waveforms. If, for 
example, you synchronize oscillator2 on oscillator1, oscillator2 will restart another period each 
time the first oscillator accomplishes a complete period, even if oscillator2 has not completed a 
full period (which signifies that it is not tuned to the same tonality.) The higher you tune 
oscillator2, the more you will obtain composite waveforms. 
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The complete cycle of a wave form (sawtooth) = one period  

 
 

 

In the image above, oscillator2 is synchronized with the first, and then tuned to a frequency 
with double the tonality. 
 
The noise module  

 
The noise signal spectrum possesses all frequencies at the same volume. For this reason, the 
noise module is used to create different noises like the imitation of wind or a breath, or even 
special effects. White noise is the richest of noises. Pink noise is also commonly present on 
synthesizers. It is not as rich in high frequencies as white noise, having received a low pass 
filtering.  
Also, note that the audio output of the noise can be used as a modulation signal (specially 
when it is heavily filtered) to create random cyclic variations. 
 
On pre-cabled synthesizers, the noise module is either integrated into the oscillator, (its audio 
output being placed as a complement on top of the wave form outputs) or the mixer directing 
the signals to the filter. On the other hand, on modular synthesizers, it is an independent 
module.  

7.1.2 The filter or VCF 

The audio signal generated by an oscillator (the wave form) is generally then directed towards 
a filter module (Voltage Controlled Filter). It is this module that allows the modeling of the 
sound by filtering (by subtraction, explaining the name of this type of synthesis) the harmonics 
situated around a cut-off frequency. It can be considered like a sophisticated equalizer, which 
reduces, depending on the case, the low or high frequencies of a sound. 
 
The removal of unwanted frequencies from a cut-off frequency is not sudden, but is done 
progressively, depending on the filter slope. This filter slope is expressed in dB/octave. The 
filters used in classic analog synthesizers have slopes of dB/Oct. or de 12 dB/Oct. 
The 24 dB/Oct. offers a more efficient filtering than the 12dB/Oct. 
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On the Moog Modular V, you have access to 7 different types of filtering. Lets have a look at 
their respective properties: 
 
The low-pass (low-pass filter or LPF) deletes the high frequencies from a frequency limit (the 
famous cut-off frequency) and only allows mow frequencies to pass. Depending on the setting, 
we will hear the sound becoming more or less “brilliant”, or more or less “thick”.   
 
This is the type of filtering that you will commonly find on synthesizers using subtractive 
synthesis. It is equally present on analog synthesizers as well as the most recent digital 
models. 

 
The high-pass (high-pass filter or HPF), as opposed to the low-pass, eliminates low frequencies 
and only allows high frequencies past. The sound will thus become “finer”. It is very useful for 
removing redundant low frequencies. 
 

 
 

 
The band-pass (band-pass filter or BPF) eliminates the frequencies situated on either side of 
the cut-off frequency. Use it to make a certain band of frequencies that you wish to emphasize 
appear. This will make the sound more “pinched”.  
 

 
 

 
The band-reject (band-reject filter or notch) eliminates the frequencies inside a band of 
frequencies. This filter is above all else interesting when we want to vary this band of 
frequencies (with the “frequency” on the Moog Modular V filters or the modulation of an LFO on 
this same parameter). You will thus obtain a sound close to a “phasing” effect. 
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These 4 types of filtering are more often used on analog synthesizers. The Moog Modular V 
offers 3 other types of filters, unheard of on synthesizers, but very much used on high quality 
mixing consoles or professional equalization modules:  
 
The bell filter amplifies or dampens a frequency band (in function with the gain knob) 
 

 
 

 
The low-shell filter amplifies or dampens the frequencies under the cut-off frequency (with the 
action of the gain knob). 
 

 

 
The high-shell filter increases or decreases the frequencies above the cut-off frequency (with 
the action of the gain knob). 
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A second setting completes the cut-off frequency: the resonance. 
(You will also find it under the terms “emphasis” or “Q” – as a filtering quality factor) 
The resonance amplifies the frequencies close to the cut-off frequency; the other remaining 
frequencies are unchanged (before the cut-off frequency) or diminished (after the cut-off 
frequency). 
You can increase the rate of resonance by simply turning the resonance knob. 
 
When you increase the resonance, the filter becomes more selective, the cut-off frequency is 
amplified, and the sound begins to “whistle”. 
 
With a high level of resonance, the filter will begin to oscillate on its own, producing a sound 
close to a sinusoidal waveform. At this stage, the use of a key follow is very important as you 
can create a melody by tuning the filter cut-off frequency with the frequency of the oscillators. 
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7.1.3 The amplifier or VCA    

The amplifier (Voltage Controlled Amplifier) is charged with receiving the audio signal coming 
from the filter (or directly the one from the oscillator if it is not filtered) to adjust its volume 
with a knob, before the signal is directed to the speakers.   
 
In conclusion, here is a scheme that may help you to understand the composition of a basic 
sound: 

 

7.2 COMPLIMENTARY MODULES  

7.2.1 The keyboard 

If we hold down a key at this stage, the sound you will get from the speaker will be uniform, 
without life and without end. In fact, the oscillator delivers a continuous signal (the audio 
output of a wave form) of a fixed pitch. In the scheme above, the only means of stopping this 
sound that quickly becomes unsupportable is by lowering the filter cut-off frequency so that it 
becomes more and more thick until it disappears; or more simply, to lower the volume of the 
amplifier.  
 
To trigger and stop this sound, and this, at the tone that we want, we use a keyboard, which 
will be connected to the oscillator. This will “play” as soon as a key is pressed and will mute it 
as soon as released. Of course, this connection is made through MIDI (it replaces the “gate” 
type connection of analog synthesizers, which triggers the sound when the key is pressed and 
stops when released). 
In the second case, so that the sound is correctly tuned with the keyboard notes, we need to 
apply a key follow modulation (replacing the 1Volt/octave control present on most analog 
synthesizers). 
 
To play the Moog Modular V with a MIDI keyboard, click on the “trigg in” plug of the output VCA and select the 

“keyboard trigger” function. For more detail, see chapter 5 paragraph 1.1.5 “Output Amplifiers (VCA)”. Next select one 

of the 4 key follow settings in the display “S1…4,off” on each “Driver” oscillator. 

 
If you don’t have a keyboard, you can play on the Moog Modular V virtual keyboard. 

7.2.2 The envelope generator  

The envelope generator, connected to the amplifier, is used to “sculpt” the form of a sound 
during a cycle, which begins when we press a note on the keyboard, and ends when we 
release. 
 
The most current envelope modules use 4 settings that we can vary:  
The Attack is the time that the sound will take to reach its maximum volume once the key has 
been pressed on the keyboard. 
The Decay is the time that the sound will take to decline after the key is played. 
The Sustain is the maximum level of volume that the sound will reach when a key is pressed. 
The Release is the decline time after the key has been released. 
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The ADSR envelope 

On the two VCA of the Moog Modular V, the envelopes include 2 supplementary settings: 
 
The Slope Time is the time of intermediary decline situated after the decay, once a key is 
pressed.  
The Slope Level is the level of intermediary decline situated after the decay, once a key is 
pressed.  
 
The envelope generator can also be used to modulate other settings like the cut-off frequency 
of a filter or an oscillator for example. 

7.2.3 The low frequency oscillator 

The LFO (Low Frequency Oscillator) possesses, among other things, the same characteristics 
as classic oscillator but does not produce frequencies inferior to 20 Hz. In other terms, you 
won’t hear the sound if you connect the audio output of an LFO in an amplifier. 
Not being used to produce a sound, it can be used to create a cyclic modulation on the 
parameter on which it is connected. 
For example:  
 
If you connect an LFO to the modulation input of an amplifier, the sound volume will increase 
and disappear in an alternate manner depending on the speed (the frequency) of this LFO. This 
will create a tremolo effect. 
 
To produce a vibrato effect, simply connect the sinusoid output of an LFO to the modulation 
input of an oscillator. The frequency of this oscillator will thus be modulated up and then down. 
 
Finally, try to connect an LFO output to the modulation input of a lightly resonant low-pass 
filter and you will obtain a “wah wah” effect. 
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VCA modulated by a LFO 

Now to finish, the scheme of a full synthesizer containing: 
3 oscillators (VCO) 
1 noise module 
1 mixer (mixing the 3 VCO and the noise module towards 2 filters) 
2 filters (VCF) 
2 amplifiers (VCA, can be placed in stereo with the pan knobs) 
3 envelopes (ADSR) 
3 LFO 
1 keyboard  
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8 A FEW ELEMENTS OF SOUND DESIGN 

Here is a series of examples designed to guide you through the creation of a sound and a 
sequence. They are classed in order of complexity beginning with the easiest, and are 
organized into 4 parts: 
 
The first part will teach you the basics of modular sound synthesis. For this you will go from 
the most basic patch (Make a VCO oscillator “ring” in an output VCA amp) to programming a 
richer sound (several VCO sources, VCF filters, VCA envelopes…) 
The second will help you to use all of the different aspects of the sequencer 
The third will show you tips on the creative use of the key follows, triggers and the creation of 
a stereophonic sound without using extra chorus and delay effects. 
The fourth and last part will guide you through the use of three of the new modules in the 
Moog Modular V 2.0: the Bode Shifter, the envelope follower and the Formant Filter. 

8.1 MODULAR SOUND SYNTHESIS 

8.1.1 Simple patch n°1 

To begin, we will learn how to program an elementary monophonic sound. It will be composed 
of 4 modules:  
 
an oscillator  
a low pass filter 
an output VCA  
the envelope corresponding to the output VCA. 
 
You will thus obtain the base patch of subtractive synthesis. 
 
Attention: If you click on one of the “Inv” buttons on the mixer VCAs, this will not change the base tone of the preset 

but will invert the signal connected to this VCA. (For example, a descending “sawtooth” signal will become ascending) 

In addition, if you apply soft clipping (light distortion) on one of the VCA, the operation will most likely use more CPU 

load than before.  

 
The following figure shows the connections for this sound as well as the position of the 
different knobs: 
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Simple patch1 

� To begin, load the “Blank_Synth” preset in the “User” / “Blank”.You will notice that it 
has no cable connection and it delivers no sound . This is normal, it is from this preset 
that you will program your sounds from scratch. 

 
� Choose a sound source on the first oscillator situated in the lower section: take the 

audio output of the saw-tooth waveform by clicking on the jack  . 
This wave form produces the richest noise signal out of the 5 wave forms proposed. It 
will be ideal for creating a “brassy” sound, for example. 

� Direct the cable to the input of the first filter (“VC Low Pass Filter”) by dragging it to the 
“In” jack. This first cable will come confirming the connection. 

 
� Now direct the audio output from this filter (“Out” jack) to the (jack “vca in”) input of 

“VCA1” (output amplifier). Make sure that the trigg input of the output amplifier (VCA1) 
selects “keyboard trigger” 

 
� Now play on your MIDI keyboard and you will hear the sound from your first patch. 

 
We recommend that you save it as it is as it will come in useful for programming basic bass or 
lead sounds. (See the “saving a sound” chapter) 
 
Tip: Turn the filter cut-off frequency button progressively to the left to change the brilliance of the sound. It will 

become increasingly “soft”. 

8.1.2 Simple patch n°2  

The sound of your first patch may seem a little empty. Here is how to make the sound more 
interesting and “fatter”. This patch will use: 
 
2 oscillators 
1 low pass filter 
1 output VCA  
1 envelope 
1 LFO 
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It will more or less constitute the classic composition of a basic synthesizer. 
You will be able to regularly reuse this patch, don’t erase it.  
 

 

Patch 2 complete 

� For more clarity, reuse the “Blank” preset. 
 

� As previously, connect the “saw” output of oscillator1 to the first mixer VCA input. Next, 
connect the oscillator2 “saw” waveform to the second VCA. 

 

 
 

Connection of oscillators to mixer 

 
� Create a link between these 2 VCA by clicking on the “link” button situated between the 

first and second VCA. This will allow you to mix these 2 sources before directing them 
towards the audio input of filter1. 
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Click on the link button to create a link between the 2 VCA 

� To connect the audio output coming from the 2 mixed VCA to the filter1 input, drag a 
cable from the first VCA “out” to the filter1 “in”.  

 

 

 

Link towards filter1 

� As was the case with the previous patch, direct the filter output towards the audio input 
of the output VCA 1. 

 
� Now increase the volume of these 2 VCA (volume knobs) so as to hear the sound 

coming from the 2 oscillators. 
 

 

Setting of the volume of the 2 mixer VCA 

� To give more life to your sound, click on the “frequency” knob on the first oscillator with 
the right click of the mouse (“Fine tune” position) then lightly turn towards the right (to 
increase the height of its tone) or the left (to decrease it). You will thus progressively 
hear a beating resulting from the light difference in tuning of the 2 oscillators. This beat 
will create a chorus effect, which will give more life and “warmth”. 
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Detuning of oscillator1 

� Hone this sound by applying light cyclic variations on the filter cut-off frequency. 
Choose, for example, the “Sin” output of LFO1 and direct it to the first modulation input 
(“Mod In”) of filter1. Click again on this jack and lightly turn it towards the right (to 14h 
for example). This will dose the modulation input to the cut-off. Finally, lower the cut-
off frequency to hear the oscillation of the sound.   

 

 
 

Connection of LFO to filter1 

Tip: Turn the resonance button to the right to create a supplementary “brilliance” that is very “electronic” in your 

sound. By increasing the oscillation speed of LFO1 (“frequency” button), you will thus obtain a typical 70’s “wahwah” 

effect.     

8.1.3 Complex patch n°1    

Let’s continue with a more complex sound using:  
3 oscillators  
the mixer 
2 low pass filters  
2 VCA 
2 envelopes (1 on each filter) 
2 LFO  
 
This sound will be polyphonic and constitute a good example of accompaniments with subtle 
stereo evolutions. 
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The complete patch 

For the conception of this sound, you can complete the previous patch. 
 

� Start by clicking on the “link” button between the second and third mixer VCA to create 
the link between these 3 VCA. 

 
� Then, on this third slice, connect the audio output of the square waveform of the third 

oscillator. 
Notice that filter1 is still connected to the audio output of the first slice of the mixer. As a 
result, it now receives the signals coming from the 3 oscillators.  
 

� Again, drag a cable from this same slice towards filter2. This of course was not possible 
on the original synthesizer, but here, we can have several connections from the same 
output. 
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Connection towards the second filter 

� Change the second filter type: for example, select the 12dB multi-mode filter by 
clicking on the button on the top left of the module.  

 
� Choose the low pass mode. Its filtering characteristics allow us to obtain a different 

color from the other filter (a 24dB band-pass). This will be very useful for the creation 
of interesting stereo effects for your accompaniment sound.  

 
� Connect the audio output of this filter to the input of the second output VCA and turn 

the pan buttons of VCA1 to 9h and those of VCA2 to 3h to widen the stereo field.  
 

 

The connections to the two VCA 

� You make your sound fuller, lightly detune the frequencies of the 3 oscillators by 
turning their respective “Fine Tune” buttons (by clicking with the right mouse button) to 
create a chorus effect.  

 
� Connect the envelope1 output to the first modulation input of filter1. Click again on the 

jack and turn it lightly (to 14h for example) towards the right. This will dose the 
modulation input directed towards the cut-off. Do the same thing on filter2 using 
envelope2.  
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If you do not hear the sound, make sure with a right click on the “trigg” inputs of these 2 
envelopes that “keyboard trigger” has been selected. 
 

� Apply light cyclic variations on the filter1 cut-off frequency. Choose the “Sin” output of 
LFO1 and direct it to the first modulation input of filter1. Lightly turn the jack to the 
right  (to 14h for example), this will dose the modulation input directed towards the 
cut-off. Lower the cut-off frequency to clearly hear the oscillation of the sound.   

 
� Do the same thing with filter2 by choosing the triangular waveform of LFO1. To create 

subtle evolutions of stereo sound, turn the modulation jack ring in the opposite 
direction of filter1. 

 

 
 

LFO1 to the filters link 

� If you wish to change the LFO oscillation speed, simply turn the “Frequency” button. 
 

� You can also create light fluctuations in the change of speed of LFO1.  

For this connect the LFO2   output to the “FM” input (Frequency Modulation) of LFO1. Turn 
the jack ring to dose the modulation. The evolution of the 2 filters will be less linear. 
 

� An accompaniment sound has a fairly slow attack, set the 2 VCA envelopes so that the 
sound appears more slowly when you press the keys of your keyboard. Turn the 2 
attack buttons (“Attack” — A) to the right: set them to 2 seconds for example.  

 
� Hone the setting of these envelopes by prolonging the decay of the sound: turn the 2 

release buttons (“Release” — R) lightly increasing them (to 500 millisecond for 
example) 
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The setting of the VCA envelops 

8.1.4 Complex patch n°2  

This fourth example will let you go a little further in the approach of different types of 
modulations. It contains:  
4 oscillators (the second being in synchro mode with the third) 
1 white noise 
3 filters (1 LP, 1 HP & 1 BP) 
2 VCA (in stereo) 
3 auxiliary envelopes 
3 LFO (the 2 principal LFO + 1 low frequency)  
 
This sound is stereo and uses delay and chorus effects. It can be as easily used in monophonic 
and polyphonic mode to create a very expressive ambient sound. 

 

 
 

The complete patch  

For this example, we recommend that you start over with the patch n°2 base. 
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� Successively connect the outputs of the waveforms   of oscillators 3 and 4 to the 
VCA inputs 3 and 4 of the mixer. 

 
� Set the “Range” of oscillator 3 to 16. It will play 1 octave upper than the 3 others  

 
� Connect the white noise output to the third filter and choose the third type of filter on 

this (the Filter Coupler). It will be very useful in creating a resonance particular to white 
noise. For this set it to Band Pass mode. 

 
� Connect the audio output of this filter to the audio input of the fifth mixer VCA. 

 
� Connect envelope1 to one of the filter3 modulation inputs and set the modulation level 

to your liking. 
 

� Increase the attack time of the envelope to 14h in order to make the sound 
progressively appear in the global sound.  

 
� Now let’s make another modulation appear given by the   of LFO2 which will be 

provoked by the aftertouch. For this, connect the “Tri” output of this LFO to the sixth 
audio input of the mixer. 

 
� Connect the “Aftertouch” output to the “Mod” input of this same slice, and direct its 

output to the second “Mod” input of filters1 & 2, without forgetting to increase the 2 
modulation levels. 

 

 
 

The white noise module connected to the band pass filter 

� Set the third filter output towards the fifth slice of the mixer and link slices 3, 4 and 5 
to direct them towards the first and second filters.  
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The mixing 

� On the fourth oscillator, set the “Synchro” mode to “ON” and to “Hard” type. Then, turn 
the “frequency” button to find the color and height of the sound that you like. This will 
also be modulated by a third LFO (for this take the “Sin” output of oscillator 7 and set it 
to “Low” mode so that it acts as a LFO).  

 
� To save on CPU load, also click on the “Key F” (for Key Follow) button to deactivate the 

keyboard connection mode. The frequency will thus be fixed. 
 

� Modify the waveform width for   and   on the first 3 oscillators by connecting the 
triangle output of LFO2 to the impulse modulation input (“PWM”) of the first “driver” 
oscillator. This will add new harmonic colors typical of analog synthesizers. Set the 
Pulse Width knob value towards the middle so that the sound does not disappear when 
the pulse width is at 10% (equivalent to the closed position of this knob).  

 

 
 

Manual pulse width setting  

� Set the resonance button of the first 2 filters to 9h and connect the “Sin” wave forms of 
LFO1 to one of their modulation inputs.  

 
� Next set the 2 modulation levels and the LFO speed to your liking. 

 
� Finally, set the 2 output VCA envelopes as you wish, while trying to keep the same 

values on the 2 envelopes. 
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Tip: If you apply several modulations provoked by the different LFOs and on different destinations (filter “Cutoff”, FM, 

PWM etc…). Try to vary the different levels of modulation in order to create as many different variations in the 

evolution of the final sound. This is one of the strongest points of modular synthesizer.    

8.2 THE SEQUENCER 

8.2.1 Sequence n°1  

Now let’s take a more detailed look at the use of the sequencer. We’ll start by creating a 
simple sequence of notes with an oscillator. Take, for example, patch n°1 from this chapter as 
the starting point. 
 

� At the bottom of the first “Driver” oscillator, click once on the sequence display 
(situated next to the one for the key follows): the display indicates “S1”. This activates 
the connection towards the first line of sequence on the sequencer. 

 

 
 

Connection of the “driver” oscillator to the first sequence line 

� Select the “Seq Trig” output by clicking on the “Trig” input of VCA1.  
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Selection of Sequencer trigger  

� Now move to the second screen and click on the “ON” button situated in the “Oscillator” 
module. The sequencer starts up but you only hear the same pitch for all the steps. 
This is normal. 

 

Start the sequencer 

� Set each knob corresponding to the first sequencer line (the one to which the sequencer 
oscillator had been directed). You can now hear a melody.  

 

 

Set the knobs of the first line of sequence  

� Set the impulse width of the square signal of the sequencer oscillator with the “Length” 
knob. This will vary the length of the notes played. 

 

 

Set the “Length” knob 

� To stop the sequencer click on the “OFF” button. 
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Sequence1 

8.2.2 Sequence n°2  

Now let’s see how to use the different combinations between knobs (by lines or columns to 
create 8, 16 or 24 step sequences). This will allow you to quickly have very different sequence 
lines available which although different will harmonize perfectly together. We will also look at 
the possibilities for the creation of ternary sequences (for example: 6, 12 or 18 steps).  
 
To begin, reuse the previous sequence...  
 

� Click 4 times on the sequence display at the bottom of the first “Driver” oscillator (the 
display indicates “S4”). This will connect the latter to the fourth sequence output. This 
will allow us to create knob line or column combinations. 

 
� Select the “L1-2” function on the line selector on the right of the sequencer. Once you 

have created a melody on the second line, you will alternately hear the melodies played 
by these two lines.  

 

 
 

Select the function “L1-2” 

 
� Do the same thing for the third line. To hear it, select “L1-2-3” and try the other 

selections and the columns (3 knobs per column) by activating “C1-2-3”. With the “Al” 
position, the playing will be done randomly between each line and column. 
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� Now let’s look at the creation of ternary sequences. For this, choose step 1 on the 

“Next” step selector of the seventh line. This will force the sequence to reset at the 
sixth column. You will thus have a 6 times sequence which can be synchronized with 
the MIDI tempo of the host sequencer (VST for example). 

 

 
 

Choose step 1 on the seventh line 

� We can now go much further by moving the sixth time towards the eighth column. For 
this, return to the initial order of the sequence (2,3,4,5,6,7,8,1) and set the eighth 
“Next” selector to 3. This time the sequence limits will be moved three steps forward all 
while producing the same number of steps.  

 
� Try playing on 12 and then 18 steps choosing the “L1-2” and “L1-2-3” functions or by 

column (“C1-2-3” etc…) or randomly with the “Al” position. The sequence playing will 
always be ternary all while creating multiple variations on the melody. 

 
� Now try to “force” the trigger of a step by clicking on the “ON” button underneath. The 

sequence will interrupt its course and continue from this one. This is interesting for 
creating other types of sequences. 

 

 
 

“Force” the triggering of a step  

� You can also “trigger” one of these steps using a MIDI keyboard by selecting “Keyboard 
Trigger” on the “Trigg” output above the “ON” button. The sequence will be triggered 
when you press one of the notes. In the same manner, you can switch lines or columns 
by selecting the same function on the “Trigg” “Chain” output.  
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Select “Keyboard trigger” on the “Trigg” output  

 

 

Sequence 2 complete 

8.2.3 Sequence n°3 

Reuse again the melodic sequence n° 1 and complete it by adding another type of modulation. 
For example, make a variation on the opening frequency of filter1 (“frequency”), which will be 
managed by the second line of knobs. Then the third line on a second VCO and finally the 
fourth on the opening frequency of filter2. 
 

� Connect the square of the fourth oscillator (in order to create a second melodic 
sequence, different from the first) to the audio input of filter2 and choose the “Low Pass 
Filter” type for this filter. 

 
� Place filter 1 on the “S2” output of the sequencer: click several times in the small 

display at the bottom of the module to show its characters. 
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Filter1 on the “S2” sequencer output   

 
� Place the second “driver” on the “S3” sequencer output. 

 
� Now connect the L4 sequencer output (at the bottom of the section) to the first 

modulation input of filter2. You can also try a positive or negative value. 
 

� Select the “Seq Trig” output by clicking on the “Trig” input of VCA2 and separate the 
knobs of the 2 VCA in order to create an evolving stereo sequence. 

 
� Move to the second section, click on the sequencer “on” button and set the 2 knobs 

lines corresponding to filter1 and VCO4. Finally, choose the type of sequence chaining 
with the fourth column.  

 
� If you wish to add a little “portamento” to a melodic line, turn the “Smooth” knob 

corresponding to your sequence line. 
 

 
 

Turn the “Smooth” knob 

� to complete the evolution of the sound in stereo, you can apply modulations to the cut-
off frequencies of the 2 filters using a LFO. To make this effect more apparent, turn the 
level of the modulation input of filter1 to the left (negative value) and of filter2 to the 
right (positive value). By applying a slow rotation speed to the LFO, you will get the 
linking of the 2 sequences in stereo space, brought about by the opening of the 2 cut-
off frequencies.   

8.3 BONUS  FEATURES 

8.3.1 Creative use of key follows 

The Moog Modular V provides you with settings for 4 independent key follows. These key 
follows are mainly used to tune the oscillators in relation to the keyboard range but can also be 
used for different applications.  
 

� Try, on a filter1 cut-off frequency, opening (click several times on the key follow display 
situated at the bottom of the filter to select the “K2” key follow). It will become 
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increasingly brilliant when the height is increased of the follow slope is positive and the 
contrary if it is negative.  

 

 
 

Click several times on the key follow display 

� You can also try another type of VCA control, PWM, oscillator fine tune, LFO speed… by 
selecting one of the 4 key follows in one of the modulation inputs. 

 

 
 

Connection of the PWM to the key follow input 1 (key follow1) 

� Now move to the second screen to set the slope and the notes that will separate the 
key follow actions. For this example, choose key follow n°1. 

 
� Turn knob “k. follow slope 1” to determine the slope of this key follow. The more you 

increase the value, the more important the slope and the faster the opening of the filter 
will be performed when the keyboard range is played.    

 
 

Setting of the key follow slope 
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� To obtain an inverted slope (the higher you go in the scale on your keyboard, the faster 
the filter will close), connect the key follow1 output to the filter modulation input and 
turn the modulation jack ring counter clockwise. 

 

 
 

Turn the modulation jack ring counter clockwise. 

� Each of the key follows also allow the generation of a trigger signal when the selected 
note is between 2 limits. Because of this, certain envelopes can be triggered in function 
of notes or particular sections of the keyboard. 

 

 
 

Setting the limits for the key follows 
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8.3.2 Creative use of triggers and trigger delays 

All of the Moog Modular V envelopes are triggered by specific signals. These signals can be 
generated by the keyboard (note On, note Off), by each of the 4 key follows, by the sequencer 
or by the trigger delay module. 
 

� Simply click on the trigg “in” plug on the envelope to choose a trigger mode. 
 

 

Click on the trigg “in” plug on the envelope 

� Generally the envelope is triggered by the keyboard. The use of a trigger delay allows 
you to make the modulation appear after a determined time, as long as the note is still 
active. You will obtain a different sound depending on the length of the note. 
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Choose the “dual trigger” option on the envelope  

� The starting and stopping of the sequencer can also be done using a trigger signal. 
Triggered by the keyboard the sequencer is initialized on every On note. You will obtain 
trigger synchronization by playing the MIDI keyboard. Triggered by a particular note, 
the sequencer can appear only after an introduction for example. 

 

 

Sequencer startup through a MIDI keyboard 

8.3.3 Stereo without the effects 

Obtaining a stereo sound comes down to treating 2 independent channels. Each of the output 
VCA is positioned in stereo space using the “pan” knob.  
 

� Set the VCA1 “pan” to the left, and the VCA2 to the right to create 2 independent 
channels needed for convincing stereo.  

 

Setting the output VCA panoramic 
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� Connecting a different oscillator to each of the VCA allows you to obtain a very wide 
space. To make it evolve, apply a light detuning to one of the oscillators using a LFO or 
an envelope. The sound will seem like it’s turning in space, or in the second case, 
passing from one point to another. 

 
� To keep the stereo space very wide, it is essential to keep the 2 channels independent. 

Il It is thus necessary to use a filter for each of them. These filters can then be 
modulated in an identical manner, or differently without interfering with the stereo 
space. 

 
� For a right to left movement, you can also modulate the output VCA with an auxiliary 

envelope, once connected, set the modulation level to a positive value for one and 
negative for the other. 

 

 

Connection of an auxiliary envelope for the output VCA 

These patches, you will have noticed have very different levels of difficulty. We hope that they 
will have allowed you to see some of the possibilities that the Moog Modular V has to offer. But 
don’t hesitate in testing the programming yourself, this is how we learn and progress and 
develop more originality. 
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8.4 USING THE NEW MOOG MODULAR V 2.0 MODULES 

8.4.1 The Bode Frequency Shifter 

The Bode Frequency Shifter was certainly one of the most coveted modules while at the same 
time one of the least known in the Moog galaxy. There were around 10 sold across the world.  

 

 

The bode Shifter module 

It allows the creation of a huge number of unique sounds, which we will see, in the two 
following examples: 

8.4.1.1 More stereo width 

Obtain more stereo width by slightly dephasing the pitch of the sound. Take as an example the 
preset “Bode_Bass” (in the “Factory” bank).  
 
For this very simple preset, we will use an oscillator where the “sawtooth” signal will be 
directed straight to the Bode Frequency Shifter audio in. 
 

� The A and B outputs on the Bode Frequency Shifter are directed towards the inputs for 
VCA1 and 2. The panoramic knobs are turned to the left for VCA1 and to the right for 
VCA2 to obtain a stereo sound. 

 
� The main tuning frequency on the Bode Shifter is placed at 0.000 Hz (“amount of shift” 

knob centered). The “Scale” setting is placed to position “5” (the variations in height 
are very weak). Also, leave the “Mixture” setting at the center (it won’t be used in this 
example) 

 
� A slow modulation is applied to the Bode Shifter frequency thanks to the sine signal of a 

LFO.  
  
The modulation phase being inverted on outputs A and B, you obtain a very natural dephasing 
between the left and right signals.  
This effect could be compared to a short reverberation effect if the modulation rate is weak or 
“chorus” if we increase the modulation rate. 
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The “Bode-Bass” patch 

8.4.1.2 Electronic percussion sequence  

� For this example we will use the sequencer to create a simple melody with the Bode 
Shifter. Sequence lines 1 and 2 will modulate the height of the Bode frequency (” 
Frequency shifter modulation”). 

 
� Take the preset “Sequences”/ “Bode_Seq” in the “Factory” bank. The composition of 

modules is about the same as the previous example. A low pass 24dB filter has been 
added to filter undesirable high-pitched harmonics as output from the Bode Shifter.  

 
� The first two sequencer lines modulate two Bode Shifter modulation inputs (the first at 

a value of 0.3247 and the second at – 0.4588). The two sequences complement one 
another setting the “amount of shift” parameter.  

 
� The Bode Shifter possesses a sound close to a Ring Modulator; the resulting sound is 

slightly metallic. We can direct the signal to a low pass filter (LP filter 24 dB) to dampen 
certain high frequencies.         

 
It is also possible to use a waveform that is not as rich in harmonics on the oscillator (the triangle, for example) if we 

don’t want to filter the sound coming from the Bode Shifter. 
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The “Bode-Seq” patch 

We are not obliged to use a sequencer as source of frequency modulation for the Bode Shifter. 
More subtle modifications are also possible with a LFO or a key follow. 

8.4.2 The Envelope Follower 

The envelope follower is a module favored by aficionados of modular synthesizers with the goal 
of modulating the envelope with an external signal. (A drum line is very appropriate for this 
type of use.) The result: obtain a complex envelope following the evolution of an audio signal.  
 
It is also possible to connect any other source of modulation to the envelope follow input: An 
envelope for example. The course of the latter can be modified with the envelope follower 
parameters. 
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The “Envelope follower” module 

Let’s have a closer look at these two situations: 

8.4.2.1 Trig by an external audio source. 

In the first case, the Moog Modular V will be used as a VST insert effect for an audio track in 
Cubase SX. 
 
If you don’t have Cubase, know that the procedure remains globally the same for any other 
sequencer.  
 

� Firstly, place a sample (preferably a drum loop) on an audio track on the sequencer. 
 

� Open a VST “Insert” effect on this track by choosing “Moog Modular V2 FX”. 
 

� On a MIDI track, choose the Moog Modular V 2 FX  as MIDI control output. It will thus 
be controlled by your master keyboard or by a sequence recorded in the arrangement. 
This point is essential for generating the sound of the Moog Modular V2. 

                                                                   
 It is also possible to create a continuous note (hold) so that the Moog signal doesn’t stop. 

For this, set the “Release” knob on the VCA1 envelope fully to the right (in the direction of the hands of a clock). 

 
� On the Moog, choose the “EFX/ Ext_In” preset in the “Factory” bank. The “Ext Left” 

audio in (on the lower section) is connected to the envelope follower audio in. This 
indicates that the audio signal will guide the envelope.  
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The “Ext_In” preset 

� This module will be used to modulate the low pass filter frequency (LP Filter 24 dB). 
After “opening” the modulation rate, the filter cut-off frequency will be modified by the 
dynamic evolutions of the audio signal when the Moog is played through MIDI. 

 
� You can modify the curve of the envelope with the “Time Follower” setting situated 

under the “Threshold” knob. 

8.4.2.2 Create your LFO form  

Here we will see how you can create your own complex LFO waveform. 
 

� Use the preset “Pads / Env_Follow” in the “Factory” bank. It has two oscillators as 
sound source, a low pass filter (LP Filter 24dB), an envelope follower and 3 oscillators 
(two sine and one sawtooth) which are used as a base for creating a complex wave 
form that will modulate the filter cut-off frequency.  
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The preset “Pads / Env_Follow” 

� To modify this wave form, we will connect the result of the mixing of the 3 oscillators as 
source of modulation to the input of the envelope follower. Click on the audio out of the 
first VCA (going from the left). 

 
� Turn the “Time Follower” knob (below the “Threshold” knob) to modify the amplitude. 

8.4.3 The sample and hold  

The Moog sample and hold module was only introduced on the last modular systems (1974). It 
is widely used for the creation of random modulations (the famous sounds from R2D2 in Star 
Wars were created in this manner).  
It can also be used for more rhythmic cyclic modulations. 
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The Sample and hold Module 

Here we will look at creating a random modulation. 
 

� Use the “Pads / Slow_SH” preset from the “Factory” bank for this example. It is made 
up of 3 oscillators, a low pass filter (LP Filter 24dB), a noise module and a Sample and 
Hold. 

 

 

 The “Slow_SH” preset 

The pink noise output is filtered by a low pass filter (6dB/oct) and directed to the Sample & 
hold audio in. The audio out of the latter is connected to one of the 3 cut-off frequency 
modulation inputs of the low pass filter. 
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� The result is random changes to the filter cut-off frequency. 
 

� Now set the modulation rate by turning the “Clock rate” knob on the Sample and Hold 
module. 

 
If you want to soften these variations there are two solutions: 
� By setting the filter cut-off frequency on the “Noise” module, the high-pitched 

frequencies will be filtered. The variations in modulation will be “softened” in this 
manner. 
 

� By using the “Glide” knob on the “Sample and Hold” module, these modulation 
variations will be smoother. 

 
The new modules included with the Moog Modular V 2.0 will add a large number of editing 
possibilities. They were difficult to create (impossible in some cases) before. Don’t hesitate to 
experiment in new editing methods. 
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9 USING THE MOOG MODULAR V IN DIFFERENT MODES 

9.1 STAND-ALONE 

The Moog Modular V application can be used as an instrument independent of a sequencer 
(stand alone mode). It allows you to open one or several instruments, and to play with a 
master MIDI keyboard. 
 

9.1.1 Launching the application 

To launch the Moog Modular V application from Windows, go to Start > Arturia > Moog 

Modular V 2 and choose Moog Modular V 2. 
On Macintosh, open the installation folder and double click on the Moog Modular V 2 
application icon. 
 
You can also double click on a saved document in order to open the corresponding 
configuration in the Moog Modular V 2 application.  

9.1.2 Setting preferences 

The preferences window allows you to set the global preferences in the Moog Modular V 2 
application. These settings are automatically saved. 
 
To display the preferences window go to the File > Preferences menu on Windows and Moog 
Modular V 2 > Preferences on Mac. 

 

The preferences window 
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The Macintosh preferences window 

Protocol (Windows only): Select the audio protocol that you want to use. If you have ASIO 
drivers for your sound card, it is highly recommended that you use the ASIO protocol; the 
ASIO drivers propose a higher performance rate in relation to the DirectX driver. The free 
ASIO4ALL driver is available to download at this address: http://www.asio4all.com/ 

On Macintosh you won’t need to use another driver that proposed by your 
machine.   

Driver: Select the driver corresponding to the sound card that you want to use. 
Sample rate: Here choose a sample frequency among those offered by your sound card.  
Latency: Here you can set the optimal audio latency in relation to the performance of your 
sound card and your system. However, a latency set too low may cause occasional jumps in 
the sound. 
Knob mode: Here choose the instrument knob control mode.  
 
 

9.1.3 The control bar 

Each instrument has a control bar setting the routing of MIDI events as input, and sound as 
output. 

 

The Windows control bar 

 

The Macintosh control bar 

9.1.3.1 Configuration of MIDI routing 

The first section of the tool bar is for selecting the MIDI input that will be applied to the 
instrument.  
Choose the MIDI port you are using to control the instrument, and the channel that you wish 
to use. You can choose to respond to one or all of the channels of this MIDI port by selecting 
‘All’ or a selected MIDI Channel number in the MIDI channel choice. 

9.1.3.2 Configuration of the keyboard zone 

The keyboard zone allows you to use only a section of the keyboard to control the instrument. 
In this manner, you can play several instruments on the same keyboard, each instrument 
responding to a different zone. 
To activate this function, check the ‘range’ option in the tool bar. You can then limit the 
keyboard zone by setting the lowest and highest note to be applied to this instrument. 
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9.1.3.3 Configuration of the octave 

The octave allows you to transpose the notes of your keyboard by one or several octaves. This 
function is interesting if your keyboard doesn’t cover the octave in which you wish to play or if 
you have activated the keyboard zone option. 

9.1.3.4 Configuration of the audio input and output 

The two last parts of the toolbar are used to select the audio channel on which you wish to 
play this instrument, and the one that will provide audio output. 
 
If the selected soundcard has several audio outputs, and respectively audio inputs, you will 
find those available in this list. Just choose the pair of outputs or inputs that you desire. 

9.1.4 Information on the level of processor use 

 
The processor usage gauge allows you to monitor the level of processor load in real time.  
 
On Windows, this gage is directly visible in the instrument tool bar.  
 
On Mac, you can display it by choosing Window > Cpu in the application menu or from the 

shortcut + L. 
 
Attention: this information only comprises the processor load corresponding to the sound synthesis; it is therefore 

subordinate to the global system load. 

9.1.5 Panic 

If notes remain active without reason, it is possible to send a MIDI message to the instruments 
in order to cut all of the notes that won’t stop when released. 

On Windows, click on the  icon in the instrument tool bar. 

On Mac, this command is found in the Help > Panic menu or through the shortcut + + P  

9.1.6 Saving an instrument 

 
Saving allows you to save the state of an instrument, that is to say its sound settings, but also 
the audio and MIDI configuration. 
To save a configuration, just select File > Save or File > Save as … to save the configuration 
under a new name. 
 
 
Attention: if saving a configuration in the Moog Modular V application saves the sound settings of the instrument, this 

has nothing to do with the saving of the presets of the instrument itself (cf. 4.1.3 Saving a user preset). The saving in 

the application does not imply the saving of the current preset. 

 

9.2 USING YOUR PLUG-IN IN A HOST 

9.2.1 Midi connection 

Before using your plug-in with a host, please check that the Midi connection between your 
computer and the Midi device is operational. It can be verified by playing in Standalone mode 
with the appropriate direct MIDI routing to the application.  
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 There is an alternative way to check the Midi connection: On Windows, the MidiOx software can be use to see the 

Midi Data travelling on your devices. On Macintosh: Midi Monitor 

 
 

9.2.2 Saving preset 

When the session is recorded, the state of the Moog Modular V is recorded as is, even if the 
programming does not correspond to any preset. For example, if you were working on preset 
“P1” on which you had modified the parameters (without having saved them under the name 
“P2”), the next time the song is opened, the Moog Modular V will load preset “P1” with the 
modifications. 
 
The drop down menu offered by the VST sequencer to save plug-in settings can of course be 
used with the Moog Modular V. Nevertheless, it is strongly recommended that you use the 
internal Moog Modular V menu: the presets saved in this manner can be used in any other 
mode (standalone or other sequencer), and can be exported as a unique file. 
 

9.2.3 Automation 

Automation works with the Moog Modular V as like any other VST plug-in (refer to the VST 
sequencer documentation for more information on the automation of plug-ins). Preset 
changing (and therefore cable changing) cannot be automated. 
 
 
 

9.3 VST™  

9.3.1 Cubase™ 

9.3.1.1 Check Plug-in setup 

 
Opening the Moog Modular V2 VST plug-in is done like any other VST plug-in, please consult 
the user manual of the host sequencer for more information. For Cubase 5, open the menu 
“Devices / VST Instruments”, and choose Moog Modular V 2 in the rack: 

 

Opening the Moog Modular V in Cubase 5 on PC 

So that the Moog Modular V can play the information coming from a MIDI track, you must 
choose a MIDI track and select the Moog Modular V as the MIDI output for this track using the 
menu in Cubase which is used for this: 
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Connection of a MIDI track to the Moog Modular V 

The events played on a MIDI keyboard are then transmitted by your sequencer to the Moog 
Modular V. It is of course possible to record these MIDI events, and use all of the sequencers 
MIDI editing possibilities. 
 

9.3.1.2 Insert an Instrument Track 

You can also create an instance of the Moog Modular V instrument by creating an Instrument 
Track in Cubase. Simply right/command click in the track listing of the project and select “Add 
Instrument Track” 

 
 

The Instrument selection dialog will appear, where you can select the Moog Modular V2. 
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Once created, the routing of the default MIDI input to the Moog Modular V is set for that track. 

 
 

9.3.1.3 Opening the instrument 

To open the Moog Modular, please click on the little Keyboard logo located below the 
instrument track output as shown on the picture : 
 

 

9.3.2 Ableton Live™ 

9.3.2.1 Check Plug-in setup 

Opening the Moog Modular V plug-in is done like any other plug-in, please consult the user 
manual of the host sequencer for more information.  
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In : Live -> Preference -> File Folder, please check that the Audio Unit and VST boxes are 
active as display below : 

 
Set the VST folder for Ableton live 

9.3.2.2 Insert an Instrument Track 

 
To insert an instrument track, open the left sided folder. All your plug-in devices are listed as 
below. Then, double click on your Instrument will create a midi track which include your Moog 
Modular. 
 

 
List of the Plug-in devices 

9.3.2.3 Opening the instrument 

 
To open your instrument, display the Live’s Detail view by double clicking on the midi track or 
press cmd + alt + L on mac or Alt Gr + L on Windows. The detail view show you the device 
and an assignable X – Y control. 
 

 
Live's detail view 

 
 

The first button is a On/Off Switch for the VST, the second one is to define the parameters of 
the instrument, and the third is to open the Moog Modular window. 
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The three buttons 

 

 Ableton Live is able to use your instrument in VST mode and Audio Unit mode if you work on a Macintosh. The text 

above works for both. 
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9.3.3 Sonar™ 

9.3.3.1 Insert an Instrument Track 

 
To insert a track in your project click on Insert -> Virtual synths ->Then choose your Moog 

Modular 
 

 
 

The program will ask you for Track option, press OK or make your own configurations. 

9.3.3.2 Opening the instrument 

To open your Virtual Moog Modular, please double click on the Midi logo on your midi track as 
below: 
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9.4 AUDIO UNIT 

9.4.1 Logic Studio™  

9.4.1.1 Check Plug-in setup 

Opening the Moog Modular V plug-in is done like any other plug-in, please consult the user 
manual of the host sequencer for more information.  
In order to check the good setup of your Audio Unit, go to Logic -> Preference -> Audio Unit 
manager as below: 

 
Go to Audio Unit Manager 

The Audio Unit Manager gives information about all the plug-in detected by Logic. Please scroll 
to the Moog Modular V2 and check that the Logic Box is ticked: 
 

 
Audio Unit list 

You are now ready to create a new instrument track. 

9.4.1.2 Insert an Instrument Track 

To insert an Audio Unit track please proceed that way: 
Click on the ‘+’ logo next to « Global Tracks » as below : 
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On the popup Windows please choose ‘Software Instrument’ and press ‘Create’. 
You Logic project now contains an empty Midi track. To assign a Moog Modular to it click on 
the Grey field above the track output (Out 1-2): 
 

 
Grey field 

 
Then go to AU Instruments -> Arturia -> Moog Modular V2 -> Stereo and select it. 
 

 
 

9.4.1.3 Opening the instrument 

In order to open the Moog Modular you must click on the previous grey field now replaced by 
the Moog Modular: 

 
Open the Instrument 

You setup is now functional and your Moog Modular is ready to be played. 
 
 
 

9.4.2 Digital Performer™  

9.4.2.1 Insert an Instrument Track 

Opening the Moog Modular V plug-in is done like any other plug-in, please consult the user 
manual of the host sequencer for more information.  
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To insert an instrument track, click on “Project” -> “Add Track” -> “Instrument Track” then 
choose the Moog Modular. 
 

 

Insert an instrument track 

9.4.2.2 Connection to a MIDI track 

So that the Moog Modular V can play the information coming from a MIDI track, you must 
choose a MIDI track and select the Moog Modular V as the MIDI output for this track using the 
menu in Digital Performer which is used for this: 
 

 

Connecting a MIDI track to the Moog Modular V 

The events played on a MIDI keyboard are then transmitted by your Digital Performer to the 
Moog Modular V. It is of course possible to record these MIDI events, and use all of the Digital 
Performer MIDI editing possibilities. 
 

9.4.2.3 Opening the instrument 

To open your virtual instrument double click the field you have just filled: 
 
 

 

Open the Moog Modular 
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9.5 PRO TOOLS™ (RTAS)  

9.5.1.1 Installation 

During the initial installation, select Install as a RTAS/HTDM plug-in. 
 
Then, when you are asked, indicate the folder in which the other RTAS and HTDM plug-ins are 
placed. Generally the path is: 
 
for Mac OS X: Library\Application Support\DigiDesign\Plug-Ins 
for Windows: C:\Program Files\Digidesign\DAE\Plug-Ins 
 
If your system can or cannot use the HTDM plug-ins or not (see the next section), the 
installation is the same. 

9.5.1.2 The RTAS and HTDM standards 

The Moog Modular V can function with the audio Digidesign motor (DAE) in two ways: 
 
As a RTAS plug-in (Real Time Audio Suite).  

 
All of the Pro Tools systems are compatible with this standard: the audio treatment is realized 
entirely by the central unit, and does not require any specific extension card (TDM system 
type). On the TDM systems, the RTAS plug-ins can only be loaded on an audio track before the 
TDM plug-ins. They can only be loaded on an Aux Input or a Master Fader. 
As a HTDM plug-in (Host Time Division Multiplexing). 

 
Only the TDM systems  (with at least one extension card) under Mac OS Classic and X can use 
these plug-ins (refer to Digidesign for the future HTDM compatibility with Windows). The latter 
work exactly like TDM plug-ins (no limitations in the insertion positions, etc…), with the 
difference that in this case, the heart of the treatment is realized by the central unit, and not 
by the extension cards. 
The advantage of this standard is the subtlety of TDM, and this, loading at least the DSP of the 
cards. 
 
Recap on the compatibilities:   

 
 Mac OS X 2000/XP/Vista 

TDM System  RTAS and HTDM 
(stereo in/stereo out) 

RTAS 
(stereo in/stereo out) 

Other Systems 
(Pro Tools LE, Free) 

RTAS (mono in/stereo out 
and stereo in/stereo out) 

RTAS (mono in/stereo out 
and stereo in/stereo out) 

 
 

9.5.1.3 Insert instrument track 

Access to the Moog Modular V plug-in is done like any other plug-in, through for example an 
audio track insert: 
 
To create a new instrument track click on: Track -> New track -> Instrument track (please set 
it up as a stereo track) as below: 
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Add a track 

Once this is done you will need to insert the Moog Modular as an Insert, so to do it click on: 
Window -> Mix View, the window shows the empty instrument track with its Inserts field.  
 
Click on an Insert field and select: Multichannel plug-in -> Instrument -> Moog Modular V2 
The image below shows the different steps: 
 

 

Insert the Moog Modular V2.5 

To open you instrument click on the same Insert area: 

 

Open the RTAS plug-in 

Protools is now ready to play the Moog Modular V2. 
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MOOG MODULAR V2.5 

END USER LICENSE AGREEMENT 
 
 
In consideration of payment of the Licensee fee, which is a portion of the price you paid, 
Arturia, as Licensor, grants to you (hereinafter termed “Licensee”) a nonexclusive right to use 
this copy of the Moog Modular V2.5 program (hereinafter the “SOFTWARE”). 
 
All intellectual property rights in the software belong to Arturia SA (hereinafter: “Arturia”). 
Arturia permits you only to copy, download, install and use the software in accordance with the 
terms and conditions of this Agreement.  
The product contains product activation for protection against unlawful copying. This system is 
known as Syncrosoft and permits a permanent use of the software only after the activation 
process has been totally completed. The software can be used only together with the 
Syncrosoft key (dongle) and/or the Soft-eLicenser; the OEM software can be used only 
following registration. 
Internet access is required for the activation process. The terms and conditions for use of the 
software by you, the end user appear below. By installing the software on your computer you 
agree to these terms and conditions. Please read the following text carefully in its entirety. If 
you do not approve these terms and conditions, you must not install this software. In this 
event give the product back to where you have purchased it (including all written material, the 
complete undamaged packing as well as the enclosed hardware) immediately but at the latest 
within 30 days in return for a refund of the purchase price.  
 
1. Software Ownership 

Arturia shall retain full and complete title to the SOFTWARE recorded on the enclosed disks and 
all subsequent copies of the SOFTWARE, regardless of the media or form on or in which the 
original disks or copies may exist. The License is not a sale of the original SOFTWARE. 
 
2. Grant of License 

Arturia grants you a non-exclusive license for the use of the software according to the terms 
and conditions of this Agreement. You may not lease, loan or sublicense the software. 
If the software is protected by the Syncrosoft key alone, you may install a license for the 
software on one or at most 3 computers which are in your possession. The software may be 
used only on one of the computers at the same time by using the Arturia key.  
If the software is protected by the Soft eLicenser (alone or together with the Arturia key) or 
has been sold to the first end user together with other software and/or hardware (hereinafter: 
"OEM software"), you may install and use a license for the software only on one computer 
which is in your possession. Purchasing a Syncrosoft key makes it easily possible to use the 
software on three computers if needs occur. 
The use of the software within a network is illegal where there is the possibility of a 
contemporaneous multiple use of the program.  
You are entitled to prepare a backup copy of the software which will not be used for purposes 
other than storage purposes.  
You shall have no further right or interest to use the software other than the limited rights as 
specified in this Agreement. Arturia reserves all rights not expressly granted. 
 
3. Activation of the Software 

Arturia may use a compulsory activation of the software and a compulsory registration of the 
OEM software for license control to protect the software against unlawful copying. If you do not 
accept the terms and conditions of this Agreement, the software will not work. 
In such a case the product including the software may only be returned within 30 days 
following acquisition of the product. Upon return a claim according to §11 shall not apply. 
 
4. Support, Upgrades and Updates after Product Registration 

You can only receive support, upgrades and updates following the personal product 
registration. Support is provided only for the current version and for the previous version 
during one year after publication of the new version. Arturia can modify and partly or 
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completely adjust the nature of the support (hotline, forum on the website etc.), upgrades and 
updates at any time. 
The product registration is possible during the activation process or at any time later through 
the Internet. In such a process you are asked to agree to the storage and use of your personal 
data (name, address, contact, email-address, and license data) for the purposes specified 
above. Arturia may also forward these data to engaged third parties, in particular distributors, 
for support purposes and for the verification of the upgrade or update right.  
 
5. License module (Syncrosoft Key and/or Soft eLicenser) 

Arturia uses a hardware device connected through the USB connection of a computer, the 
"Syncrosoft key" and/or a protection scheme, the "Soft eLicenser" for license control 
(hardware and/or software dongle). The Syncrosoft key and/or Soft eLicenser permanently 
saves the license information and regulates access to the software. If a Syncrosoft key is 
required for the use of the software, then the Syncrosoft key must be connected physically to 
the computer through the USB interface. 
For the activation of the software, updates or upgrades of the software the computer which is 
connected to the Arturia key and/or using the Soft eLicenser or using the OEM software must 
be connected to the server of SIA Syncrosoft through the Internet. If the product was 
delivered with the Syncrosoft key, the license information was already transferred to the 
Syncrosoft key. If the product was delivered with a product card (without the Syncrosoft key), 
the activation codes of the enclosed product card must be entered manually by the user upon 
installation and the license information must be exchanged with the server of SIA Syncrosoft. 
In the event of OEM software, the activation codes will be send to an email-address submitted 
by you during a registration and must be entered manually by the user upon installation and 
the license information must be exchanged with the server of SIA Syncrosoft. 
The reinstallation of the software - on the same or another computer - is permitted only in 
case the already installed software cannot be used any more (e.g. following deinstallation). If 
the software does not use a Syncrosoft key, the new activation codes may be obtained from 
the users online account for support created during the personal product registration. Further, 
the activation codes must be entered manually by the user upon installation and the license 
information must be exchanged with the server of SIA Syncrosoft. Arturia may require for the 
provision of further activation codes e.g. your proof of purchase (invoice, receipt) and a signed 
assurance by fax or letter stating your name, address and that the already installed software 
cannot be used any more.  
You can also use another computer other than the one on which the software is to be installed 
for the activation and transfer of license data to the Syncrosoft key, if the software is using a 
Syncrosoft key. However, in such a case a corresponding access software (Syncrosoft License 
Control Centre, “LCC”) must be installed on the computer connected to the Internet, which is 
subject to a separate licensing agreement. 
 
6. Defect and loss of the Syncrosoft key 

In the case of a defect or damage to the Syncrosoft key Arturia or a third party engaged by 
Arturia will check the Syncrosoft key. In the case of a legitimate claim the Syncrosoft key and 
the licenses included shall be replaced in return for a handling fee. The licenses will only be 
replaced provided that they are licenses issued by Arturia. Further claims against Arturia are 
excluded. 
Arturia assumes no liability or obligation if the Syncrosoft key is mislaid as a result of loss, 
theft or otherwise. Arturia reserves the right to block the licenses saved on the Syncrosoft key 
upon being notified by the registered user of the loss. The licenses saved on the Syncrosoft 
key cannot be replaced.  
 
7. No Unbundling 

The software usually contains a variety of different files which in its configuration ensure the 
complete functionality of the software. The software may be used as one product only. It is not 
required that you use or install all components of the software. You must not arrange 
components of the software in a new way and develop a modified version of the software or a 
new product as a result. The configuration of the software may not be modified for the purpose 
of distribution, assignment or resale.  
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You may also not sell the Syncrosoft key separately as a license; the usage rights always 
remain with the software, in particular with the original software data carrier (e.g. CD). 
 
8. Assignment of Rights 
You may assign all your rights to use the software to another person subject to the conditions 
that (a) you assign to this other person (i) this Agreement and (ii) the software or hardware 
provided with the software, packed or preinstalled thereon, including all copies, upgrades, 
updates, backup copies and previous versions, which granted a right to an update or upgrade 
on this software, (b) you do not retain upgrades, updates, backup copies und previous 
versions of this software and (c) the recipient accepts the terms and conditions of this 
Agreement as well as other regulations pursuant to which you acquired a valid software 
license. 
A return of the product due to a failure to accept the terms and conditions of this Agreement, 
e.g. the product activation, shall not be possible following the assignment of rights. 
 
9. Upgrades und Updates 

You must have a valid license for the previous or more inferior version of the software in order 
to be allowed to use an upgrade or update for the software. Upon transferring this previous or 
more inferior version of the software to third parties the right to use the upgrade or update of 
the software shall expire. 
The acquisition of an upgrade or update does not in itself confer any right to use the software.  
The right of support for the previous or inferior version of the software expires upon the 
installation of an upgrade or update. 
 
10. Limited Warranty 

Arturia warrants that the disks on which the software is furnished to be free from defects in 
materials and workmanship under normal use for a period of thirty (30) days from the date of 
purchase. Your receipt shall be evidence of the date of purchase. Any implied warranties on 
the software are limited to thirty (30) days from the date of purchase. Some states do not 
allow limitations on duration of an implied warranty, so the above limitation may not apply to 
you. All programs and accompanying materials are provided “as is” without warranty of any 
kind. The complete risk as to the quality and performance of the programs is with you. Should 
the program prove defective, you assume the entire cost of all necessary servicing, repair or 
correction. 
 
11. Remedies 

Arturia's entire liability and your exclusive remedy shall be at Arturia's option either (a) return 
of the purchase price or (b) replacement of the disk that does not meet the Limited Warranty 
and which is returned to Arturia with a copy of your receipt. This limited Warranty is void if 
failure of the software has resulted from accident, abuse, modification, or misapplication. Any 
replacement software will be warranted for the remainder of the original warranty period or 
thirty (30) days, whichever is longer. 
 
12. No other Warranties 
The above warranties are in lieu of all other warranties, expressed or implied, including but not 
limited to, the implied warranties of merchantability and fitness for a particular purpose. No 
oral or written information or advice given by Arturia, its dealers, distributors, agents or 
employees shall create a warranty or in any way increase the scope of this limited warranty. 
 
13. No Liability for Consequential Damages 

Neither Arturia nor anyone else involved in the creation, production, or delivery of this product 
shall be liable for any direct, indirect, consequential, or incidental damages arising out of the 
use of, or inability to use this product (including without limitation, damages for loss of 
business profits, business interruption, loss of business information and the like) even if Arturia 
was previously advised of the possibility of such damages. Some states do not allow limitations 
on the length of an implied warranty or the exclusion or limitation of incidental or 
consequential damages, so the above limitation or exclusions may not apply to you. This 
warranty gives you specific legal rights, and you may also have other rights which vary from 
state to state. 
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